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another program that follows our outlined procedures could be in violation 
of the Photon Inc. copyright. 

Reproduction or use of any portion of this manual is prohibited without 
expressed written permission from Photon Inc. Reasonable efforts have 
been taken in the preparation of this manual to ensure its accuracy. 
However, Photon Inc. assumes no liability resulting from any errors or 
omissions in this manual or from the use of the information obtained 
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WARRANTY POLICY 
Photon’s products are covered by limited warranty on parts and labor for 12 months from shipment date and13 
months if shipped to an authorized representative except as noted below. This warranty covers parts and 
labor to repair the equipment that fails to perform due to problems that are innate to the units and its 
components, but not due to neglect or misuse. Photon cannot be held liable for any damages beyond the 
original equipment cost. 

Photon does not warrant incorrect use of instruments such as but not limited to: 
99  Connecting or disconnecting a Photon sensor head or a plug-in card with the computer or Photon 

controller powered on. 
99  Plugging a Photon sensor head into a game port. 
99  Plugging your Photon controller or your computer into a wall outlet without a surge protection strip. 

Photon reserves the right to determine if the problem has been brought on by improper use. 

Photon DOES NOT WARRANT DAMAGE TO APERTURES OR DETECTORS FOR ANY REASON. This 
includes but is not limited to the following: contamination, laser damage, puncture to apertures, melted 
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warranty coverage. 

Photon reserves the right to void the warranty, if the Buyer fails to meet the terms of purchase such as, but 
not limited to, a payment after the stated agreed invoice payment date or failure to pay for shipping charges as 
examples. 

This is Photon’s sole warranty with respect to its products.  No statement, agreement or understanding, oral or 
written, made by an agent distributor, representative or employee of Photon, which is not contained in this 
warranty will be binding upon Photon, unless made in writing and executed by an officer.  Photon makes no 
other warranty of any kind whatsoever, expressed or implied, and all implied warranties of merchantability and 
fitness for particular use, which exceed the aforementioned obligation, are hereby disclaimed by Photon and 
excluded from this agreement.  Under no circumstances shall Photon be liable to Buyer in contract or in tort, 
for any special, indirect, incidental or consequential damages, expenses, losses or delays however caused. 

Photon must be notified of any defect or nonconformity, and the defective product must be returned to 
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Software License Agreement 
This legal document is an agreement between you, the end user, and Photon Inc. BY OPENING THE SEALED SOFTWARE 
PACKAGE, YOU ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES 
THE SOFTWARE DISCLAIMER OF WARRANTY (collectively the “Agreement”). 
THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND PHOTON INC. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT OPEN THIS PACKAGE. PROMPTLY RETURN THE 
UNOPENED PACKAGE AND THE OTHER ITEMS (INCLUDING WRITTEN MATERIALS AND BINDERS OR OTHER 
CONTAINERS) THAT ARE PART OF THIS PRODUCT, TO THE PLACE WHERE YOU OBTAINED THEM. 
THIS AGREEMENT INCLUDES ALL MATERIALS PROVIDED IN THE SEALED SOFTWARE PACKAGE INCLUDING 
ALL MATERIALS PRODUCED, MANUFACTURED, DISTRIBUTED, PACKAGED, BUNDLED OR OTHERWISE 
INCLUDED BY PHOTON INC. IN THE SEALED SOFTWARE PACKAGE INCLUDING SOFTWARE FROM OTHER 
VENDORS, MANUFACTURERS, DEVELOPERS AND SUBCONTRACTORS. 

Photon Inc. Software Site License 

1. GRANT OF LICENSE. This product consists of software to be used with any Photon Inc. instrument product; e.g., 
NanoScan, ModeScan, USBeamPro, FireWire BeamPro, BeamScan, BeamProfiler, Goniometric Radiometers. In 
consideration of payment of the license fee, which is part of the price you paid or agreed to pay upon receipt of the invoice 
from Photon Inc. for this product, Photon Inc., as LICENSOR, grants to you, as the LICENSEE, a personal, nonexclusive 
license to make and use copies of the applicable Photon Inc. instrument analysis software program (hereinafter, “PHOTON 
SOFTWARE”). You may install copies of PHOTON SOFTWARE on an unlimited number of computers at a single 
location, providing that only one individual at a time is using the PHOTON SOFTWARE. If you are an entity, Photon 
grants you the right to designate one individual within your organization to have the right to use the PHOTON SOFTWARE 
in the manner provided above. Photon Inc. reserves all rights not expressly granted to LICENSEE. 

2. OWNERSHIP OF PHOTON SOFTWARE. As the LICENSEE, you own the magnetic or other physical media on which the 
PHOTON SOFTWARE is originally or subsequently recorded or fixed, but Photon Inc. retains title and ownership of the 
PHOTON SOFTWARE recorded on the original disk or tape and all subsequent copies of PHOTON SOFTWARE, 
regardless of the form or media in or on which the original and other copies may exist. This license is not a sale of the 
original PHOTON SOFTWARE or any copy. 

3. COPY RESTRICTIONS. This PHOTON SOFTWARE and the accompanying written materials are copyrighted. 
Unauthorized copying of the PHOTON SOFTWARE is expressly forbidden. You may be held responsible for any 
copyright infringement that is caused or encouraged by your failure to abide by the terms of this License. Subject to these 
restrictions, and if the PHOTON SOFTWARE is not copy-protected, you may make up to three (3) copies of the PHOTON 
SOFTWARE solely for backup purposes. You must reproduce and include the copyright notice on the backup copy. 

4. USE RESTRICTION. As the LICENSEE, you may physically transfer PHOTON SOFTWARE from one computer to 
another, provided that the PHOTON SOFTWARE is used by one individual at a time at one location. 

5. TRANSFER RESTRICTIONS. This PHOTON SOFTWARE is licensed only to you, the LICENSEE, and may not be 
transferred to anyone without the prior written consent of Photon Inc. Any authorized transfer of the PHOTON 
SOFTWARE shall be bound by the terms and conditions of this Agreement. In no event may you transfer, assign, rent, 
lease, sell, or otherwise dispose of the PHOTON SOFTWARE on a temporary or permanent basis except as expressly 
provided herein. 

6. TERMINATION. This license is effective until terminated. This license will terminate automatically without notice from 
Photon Inc. if you fail to comply with any provision of the License. Upon termination you shall destroy the written 
materials and all copies of the PHOTON SOFTWARE. 

7. UPDATE POLICY. Photon Inc. may create, from time to time, updated versions of the PHOTON SOFTWARE. At its 
option, Photon Inc. will make such updates available to the LICENSEE. 

8. MISCELLANEOUS. This agreement is governed by the laws of the State of California. 
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Disclaimer of Warranty and Limited Warranty 

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIAL (INCLUDING INSTRUCTIONS FOR USE) ARE 
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. FURTHER, PHOTON INC. DOES NOT WARRANT, 
GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF 
THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, 
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU, AND 
NOT PHOTON INC. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
Photon Inc. warrants to the original LICENSEE that the medium on which the SOFTWARE is recorded is free from defects in 
materials and workmanship under normal use and service for a period of ninety (90) days from the date of delivery as evidenced 
by a copy of the receipt. If failure of the medium has resulted from accident, abuse, or misapplication, Photon Inc. shall have no 
responsibility to replace it or refund the purchase price. Any replacement disk or tape will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer. 
THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPESSED OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, THAT ARE MADE BY PHOTON INC. ON THE PHOTON INC. PRODUCT. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY PHOTON INC., ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES 
SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY 
NOT RELY ON ANY SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. 
YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE. 
NEITHER PHOTON INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR 
DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR 
INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF OR INABILITY TO USE SUCH 
PRODUCT EVEN IF PHOTON INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE 
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
This Disclaimer of Warranty is governed by the laws of the State of California. 
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11..  INTRODUCTION 

1.1. System Overview 

1.1.1. FireWire BeamPro Models 2512, 2518 and 2523  

The FireWire BeamPro Models 2512, 2518 and 2523 are PC based optical 
beam profiling systems offering a unique combination of performance and 
ease of use. Highly accurate NIST traceable measurements can be made 
on both pulsed and CW lasers, over a wide range of wavelengths, beam 
diameters, and power/energy levels. Sophisticated, yet simple, Microsoft 
Windows-based software allows these results to be displayed, analyzed 
and/or archived in real time at video rates. 

The FireWire BeamPro Model 2512 includes a ½” format CCD camera with 
8.3µm pixels, the Model 2518 includes a 8.1

1 ” format CCD camera with 
4.4µm pixels, and Model 2523 includes a ⅔” format CCD camera with 
6.45µm pixels. All Models also include the FireWire BeamPro Acquisition 
and Analysis Software. 

1.1.2. FireWire BeamPro Acquisition and Analysis Software 

The FireWire BeamPro Software was written for Microsoft Windows Vista, 
Microsoft Windows XP Professional and Microsoft Windows 2000 
Professional 32 bit systems, taking full advantage of the menu driven, multi-
windowing environment. The software provides quantitative measurement of 
numerous beam spatial parameters in accordance with the ISO 13694, ISO 
11145, and ISO 11146 standards. 

Windows available for data display include: 

♦♦  Video window Displays live video images; 

♦♦  Dual Aperture 
Profile window 

Displays pinhole or slit profiles; 
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♦♦  Beam Statistics 
window 

Displays computed beam parameter 
values and statistics; 

♦♦  3D Profile View 
windows 

Displays 3-dimensional 
representations of the beam intensity; 

♦♦  2D Contour View 
windows 

Displays 2-dimensional contours of 
the beam intensity; 

♦♦  Time Statistics 
windows (up to 15) 

Displays strip chart graphs of selected 
beam parameters; 

♦♦  Pointing window Displays a target screen for observing 
beam pointing and divergence; 

♦♦  K-Factor (M2) 
window 

An interactive K-Factor Wizard 
program for measuring K-factor (M2) 
by the Rayleigh Method; 

♦♦  Notes window A simple text editor for entering user 
annotations; 

♦♦  Measurement 
window 

Displays the Beam Propagation 
Caustic. Available only for the 
ModeScan Model 1780. 

The software also performs rigorous data analysis over specific regions-of-
interest (ROIs) in accordance with the ISO standards. The ROIs can be 
either system or user defined. Quantitative measurement of numerous beam 
spatial characteristics is possible. Pass/Fail limit analysis for each of these 
parameters can be also applied. 
Parameters measured include: 

♦♦  Beam width 
♦♦  Centroid and peak location 
♦♦  Major and minor axes 
♦♦  Beam orientation 
♦♦  Ellipticity, eccentricity 
♦♦  Gaussian fit 
♦♦  Beam uniformity 
♦♦  Beam divergence 
♦♦  Pointing stability 
♦♦  M2, K-factor 

For data display and visualization, the user can arrange and size multiple 
windows as required. These may contain, for example, live video, 2D 
Topographic and 3D views, calculated beam parameters and summary 
statistics in tabular form with Pass/Fail limit analysis, and graphical strip 
chart time displays with summary statistics and overlays. Custom configured 
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instrument screens with multiple views can be saved as configuration files 
for repeated use. 

Data can be saved as program files, or exported to spreadsheets, math and 
statistical analysis programs and process/instrumentation control programs 
by logging to files or COM ports, or by sharing using ActiveX Automation. 

Live video of both pulsed and CW laser beams can be viewed in false color 
or gray scale. False color options include rainbow and four monochrome 
colors. This allows the user to choose a display color that can be seen 
clearly while wearing laser goggles. Beam profiles through the centroid, the 
peak or user defined points can be displayed. Profile orientation can be 
either in the horizontal and vertical axes or along the major and minor axes 
of elliptical beams. 
Hardware and software installation instructions, the features of the software, 
operating hints and answers to frequently asked questions are presented in 
this operating manual. 
Finally, to take full advantage of the features of the software, it is assumed 
that users have a working knowledge of the Windows operating systems 
and are familiar with basic Windows features such as opening, closing and 
saving files, making menu selections, opening, arranging, and resizing 
windows, etc. If these procedures are not familiar, see the Windows online 
Help, accessed by clicking on the Start button and selecting Help and 
Support, or refer to numerous available Microsoft Windows manuals and 
tutorials. 
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1.2. Model 2512 Camera Specifications 

Specification Model 2512 
Sensor: Si CCD 1/2" Format 

Wavelength: 
360 nm – 1100nm (Standard configuration with OD 2.8 filter) 
190nm – 1100nm (Sensor only) 

Pixel Array: 780 (H) × 580 (V) 

Pixel Size: 8.3µm × 8.3µm 

Array Dimension: 6.49mm × 4.83mm 

Scanning Mode: Progressive 

A / D Conversion: 12 Bit 

Signal to Noise Ratio: 58.4dB (maximum) 

Maximum Frame Rate: 35.8fps (full frame @ full resolution) 

Exposure range: 20µs – 27.64ms (Software selectable) 

Gain: 0 – 12dB (Software selectable) 

Image Plane: 17.526mm from the C-mount front surface 

Trigger: Internal or External (Software selectable) 

External Trigger 
Specifications: 5V ± V @ 10mA  ± 5mA (Positive transition) 

Trigger Connector: 10 pin RJ-45 Jack 

Trigger Cable: 10 pin RJ-45 to BNC 

Interface: IEEE 1394a (FireWire) 

Cable Length: 1.8m (standard) 

Supply Voltage: +8V – +36V DC (+12V DC nominal), <1% ripple (supplied 
via IEEE 1394 cable) 

Supply Power: 3.5W max @ 12V DC (typical) 

Filter/Lens Mount: C-mount (1" - 32 tpi) – 2.8 ND 

Dimensions: 49mm × 62mm × 62mm 

Weight: ~210g 

Cover Glass: Removed to eliminate interference fringes caused by 
coherent laser sources 

Operating temp: 0° – +50°C (+32°–112°F) 

Humidity: 20% – 80%, relative, non-condensing 

Conformity: CE, FCC; RoHS and WEEE 

Mounting: 1/4"-20, M6 optional 
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1.3. Model 2518 Camera Specifications 

Specification Model 2518 
Sensor: Si CCD 1/1.8" Format 

Wavelength: 
360nm – 1100nm (Standard configuration with OD 2.8 filter) 
190nm – 1100nm (Sensor only) 

Pixel Array: 1624 (H) × 1236 (V) 

Pixel Size: 4.4µm × 4.4µm 

Array Dimension: 7.15mm × 5.44mm 

Scanning Mode: Progressive 

A / D Conversion: 12 Bit 

Signal to Noise Ratio: 39dB (maximum) 

Maximum Frame Rate: 8.1fps (full frame @ full resolution) 

Exposure range: 20µs – 81.90ms (Software selectable) 

Gain: 0 – 7dB (Software selectable) 

Image Plane: 17.526mm from the C-mount front surface 

Trigger: Internal or External (Software selectable) 

External Trigger Specifications: 5V ± 1V @ 10mA ± 5mA (Positive transition) 

Trigger Connector: 10 pin RJ-45 Jack 

Trigger Cable: 10 pin RJ-45 to BNC 

Interface: IEEE 1394a (FireWire) 

Cable Length: 1.8m (standard) 

Supply Voltage: +8V – +36V DC (+12V DC nominal), <1% ripple 
(supplied via IEEE 1394 cable) 

Supply Power: 3.2W max @ 12V DC (typical) 

Filter/Lens Mount: C-mount (1"-32 tpi) – 2.8 ND 

Dimensions: 75mm × 44mm × 29mm 

Weight: ~110g 

Cover Glass: Removed to eliminate interference fringes caused by 
coherent laser sources 

Operating temp: 0° – +50°C (+32°–112°F) 

Humidity: 20%–80%, relative, non-condensing 

Conformity: CE, FCC; RoHS and WEEE 

Mounting: 1/4"-20, M6 optional 
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1.4. Model 2523 Camera Specifications 

Specification Model 2523 
Sensor: Si CCD 2/3" Format 

Wavelength: 
360nm – 1100nm (Standard configuration with OD 2.8 filter) 
190nm – 1100nm (Sensor only) 

Pixel Array: 71392 (H) × 1040 (V) 

Pixel Size: 6.45µm × 6.45µm 

Array Dimension: 8.98mm × 6.7mm 

Scanning Mode: Progressive 

A / D Conversion: 12 Bit 

Signal to Noise Ratio: 65.6dB (maximum) 

Maximum Frame Rate: 11.3fps (full frame @ full resolution) 

Exposure range: 20µs – 81.9ms (Software selectable) 

Gain: 0 – 12dB (Software selectable) 

Image Plane: 17.526mm from the C-mount front surface 

Trigger: Internal or External (Software selectable) 

External Trigger 
Specifications: 5V ± 1V @ 10mA ± 5mA (Positive transition) 

Trigger Connector: 10 pin RJ-45 Jack 

Trigger Cable: 10 pin RJ-45 to BNC 

Interface: IEEE 1394a (FireWire) 

Cable Length: 1.8m (standard) 

Supply Voltage: +8V – +36V DC (+12V DC nominal), <1% ripple (supplied 
via IEEE 1394 cable) 

Supply Power: 3.5W max @ 12V DC (typical) 

Filter/Lens Mount: C-mount (1"-32 tpi) – 2.8 ND 

Dimensions: 49mm × 62mm × 62mm 

Weight: ~240g 

Cover Glass: Removed to eliminate interference fringes caused by 
coherent laser sources 

Operating temp: 0° – +50°C (+32° – 112°F) 

Humidity: 20% – 80%, relative, non-condensing 

Conformity: CE, FCC; RoHS and WEEE 

Mounting: 1/4"-20, M6 optional 
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Photon’s products are covered by limited warranty on parts and labor for 12 months 
from shipment date and 13 months if shipped to an authorized representative 
except as noted below. This warranty covers parts and labor to repair the 
equipment that fails to perform due to problems that are innate to the units and its 
components, but not due to neglect or misuse. Photon cannot be held liable for any 
damages beyond the original equipment cost. 

Photon does not warrant incorrect use of instruments, such as but not limited to: 

♦♦  Connecting or disconnecting a plug-in card with the computer powered on. 

♦♦  Plugging your computer into a wall outlet without a surge protection strip. 
 

 

 

Warranty is not transferable except through resale of products by authorized agents 
of Photon inc. Unauthorized transfer of equipment and/or modifications to the 
equipment are grounds for voiding warranty coverage. 

Photon reserves the right to void the warranty if the Buyer fails to meet the terms of 
purchase such as, but not limited to, a payment after the stated agreed invoice 
payment date or failure to pay for shipping charges. 

This is Photon’s sole warranty with respect to its products. No statement, 
agreement or understanding, oral or written, made by an agent, distributor, 
representative or employee of Photon, which is not contained in this warranty will 
be binding upon Photon, unless made in writing and executed by an officer. Photon 
makes no other warranty of any kind, whatsoever, expressed or implied. All implied 
warranties of merchantability and fitness for particular use, which exceed the 
aforementioned obligation, are hereby disclaimed by Photon and excluded from this 
agreement. Under no circumstances shall Photon be liable to Buyer in contract or 
in tort, for any special, indirect, incidental or consequential damages, expenses, 
losses or delays however caused. 

Photon must be notified of the defect or nonconformity within the warranty period 
and the affected product returned to Photon’s factory or an authorized service 
center within 30 days after the discovery of such defect or nonconformity. Shipment 
to Photon shall be made with an RMA# and prior authorization by Photon. Warranty 
repairs will be returned pre-paid lowest cost shipping method: for example, ground 
shipment if within the USA. If a faster return is desired, the Buyer must pay the 
shipping charges. 

WWAARRRRAANNTTYY  

IINNFFOORRMMAATTIIOONN  

Photon reserves the right to determine if the 
problem has been caused by improper use. 
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22..  System Inspection 

2.1. Inspection 

If you did not inspect the shipping container prior to 
unpacking, please do so now before going any further. 

Your FireWire BeamPro Beam Profiling system has been carefully tested, 
inspected and packaged prior to shipment. Photon performs extensive testing to 
ensure that the unit is in proper working order. Upon receipt, please inspect your 
FireWire BeamPro system for the following: 

♦♦  Note any damage to the shipping container. Please report any 
damage found immediately to the shipping company. Photon 
does not warrant damage that occurs as a result of shipment. 

♦♦  Check the contents of your shipment against the packing slip 
attached to the shipping box. Please note any discrepancy. 

♦♦  A warranty form is included with all new units. Please complete 
this form and return it to Photon to activate your warranty. 

2.2. FireWire BeamPro System Packing List 
The following items are shipped as part of the FireWire BeamPro System: 

♦♦  Model 2512 ½" CCD Camera or Model 2518 1.8
1 ” CDD Camera 

or Model 2523 ⅔" CCD Camera 

♦♦  FireWire BeamPro Acquisition and Analysis Software CD for 
Windows Vista, Windows XP Professional or Windows 2000 
Professional 32 bit systems 

♦♦  FireWire (IEEE 1394a) cable 
♦♦  External trigger cable: RJ-45 10-pin to BNC 
♦♦  Operating Manual 
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33..  SYSTEM SETUP 

3.1. Personal Computer Requirements 
To ensure the successful installation and operation of the FireWire BeamPro 
system, verify that your PC has the following minimal requirements: 

♦ 1.8GHz or faster Pentium IV Processor (32-bit architecture) 
♦ Microsoft Windows XP Professional SP1 (32-bit version),  

Microsoft Windows 2000 Professional SP3 Operating 
System, or Vista Professional (32-bit version) 

♦ OHCI Compliant IEEE-1394a (FireWire) Adapter 
♦ 512 MB of RAM 
♦ CD-ROM Drive 
♦ 30MB free space on hard disk 
♦ 64MB Color SVGA Graphics Card 
♦ SVGA Display Monitor 
♦ Mouse or other Pointing Device 
♦ Keyboard 

3.2. Camera Installation 
Proper operation of the FireWire BeamPro cameras requires a standard 6-
pin IEEE-1394 connector. These 6-pin connectors can usually be found on 
desktop PCs or on PCI IEEE-1394 adapter cards. 
To install the camera connect one end of the 6-pin IEEE1394 cable provided 
with the system to the camera connector and the other end to the 6-pin port 
at the PC. 
Some laptop PCs provide a built-in 4-pin IEEE-1394 connector that does not 
provide power to the camera. In this case you will need to have an IEEE-
1394 powered hub inline (like the SIIG 1394 hub, PN: NH-H6012). 
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If you have a laptop that does not have a built-in IEEE 1394 port you will 
need an IEEE 1394-powered PC-Card and the corresponding external 
power supply. 

3.3. Software Setup 
In order to properly install and configure the software you will need 
Administrator Rights. (Please contact your system administrator for details 
regarding the Administrator Rights). 

3.3.1. Installation 
1. Insert the FireWireBeamPro CD into the CD Drive. Open 

Windows Explorer and browse to FireWireBeamPro CD and 
double click the setup.exe. 

2. Follow the instructions and, if it is possible, accept the default 
(suggested) settings. 

3.3.1.1. Microsoft Windows Vista only 

1.  Click Allow when prompted by the UAC (User Account 
Control); there will be two prompts during the installation. 

3.3.2. Uninstallation 

3.3.2.1. Microsoft Windows Vista 
1. Open the Control Panel by clicking Start then selecting 

Control Panel. 
2. Click on the word Uninstall a program under the programs 

heading. 
3. Select FireWire BeamPro and then click the Change button. 

Click Next, select Remove and then click Next to confirm 
your selection. Click Remove to start uninstalling the 
software.  Click Allow when prompted by the UAC. Click 
Finish. 

4. Select Basler Pylon Viewer 2.0.0.566 and then click the 
Uninstall button.  When prompted click yes to start removing 
the software.  Click Allow when prompted by the UAC. 

5. This completes the uninstall procedure for the software. 

3.3.2.2. Microsoft Windows XP Professional 
1. Open the Control Panel by clicking Start then selecting 

Control Panel. 
2. Click the Add or Remove Programs icon 
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3. Select FireWire BeamPro and then click the Change button. 
Click Next, select Remove and then click Next to confirm 
your selection. Click Remove to start uninstalling the 
software. Click Finish. 

4. Select Basler Pylon Viewer 2.0.0.566 and then click the 
Uninstall button.  When prompted click yes to start removing 
the software. 

5. This completes the uninstall procedure for the software. 

3.3.2.3. Microsoft Windows 2000 Professional 
1. Open the Control Panel by clicking Start then selecting 

Settings and then Control Panel. 
2. Double-click the Add/Remove Programs icon 
3. Select FireWire BeamPro and then click the Change button. 

Click Next, select Remove and then click Next to confirm 
your selection. Click Remove to start uninstalling the 
software. Click Finish. 

4. Select Basler Pylon Viewer 2.0.0.566 and then click the 
Uninstall button.  When prompted click yes to start removing 
the software. 

5. This completes the uninstall procedure for the software. 
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44..  ACQUISITION AND ANALYSIS 

SOFTWARE 

4.1. Quick Start 

4.1.1. Starting the Program 
To run the FireWire BeamPro Acquisition and Analysis Software program: 

From the Windows Start menu, select Programs, then Photon, and then 
FireWire BeamPro or select the FireWire BeamPro icon from your desktop. 

After installation when the program is first started, the Video window will 
appear. At this point the program GUI can be configured as desired with the 
multiple windows available. Alternatively, a sample startup GUI configuration 
screen is available that can be opened from the File menu. The sample 
configuration file name is “Example.fwc” and can be found in the directory 
where the software was installed, (default directory is “C:\Program 
Files\Photon\FireWire BeamPro”). There are 6 windows on this sample 
screen, including: 

♦♦  Video window 

♦♦  Profile window 

♦♦  Beam Statistics window 

♦♦  3D Profile window 

♦♦  Pointing window 

♦♦  Notes window 
Figure 4.1 below shows the Example.fwc configuration screen and the 
arrangement of these 6 windows. 
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Figure 4.1. “Example.fwc” Configuration Screen. 

The software has 3 Acquisition Modes for image acquisition and 
processing. These are accessed under the Data Collection menu or through 
the icons from the main toolbar: 

♦♦  Laser 
Positioning  

Used for positioning the laser beam in 
the sensor aperture as shown in the 
Video window. 

♦♦  Analysis 
 

Used to obtain Beam Parameters on a 
continuous basis. 

♦♦  Single Shot 
 

Used to obtain Beam Parameters one 
shot at a time. 

At first startup, the system is in Laser Positioning Acquisition Mode. 
The software has 3 Trigger Modes, accessed under the Data Collection 
menu: 

♦♦  CW for CW lasers; 
♦♦  Pulsed for Pulsed lasers where an external sync trigger is 

NOT available; 
♦♦  External for Pulsed lasers where an external sync trigger is 

available. 
 
At first startup, the system is in CW Trigger Mode. 
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4.1.2. Position the Laser Beam in the Aperture 
To begin collecting data, select Global Data Collection from the Data 

Collection menu, or alternatively, use the  icon on the toolbar, or depress 
the Ctrl+G ‘Hot Key’. The Video window will now be displaying data. The 
other windows will remain blank because data processing is inhibited in 
Laser Positioning mode to provide the fastest video update. 

Adjust the laser beam steering or the camera position until the beam image 
is centered in the aperture as viewed in the Video window. The Video 
window uses false color schemes to code the beam intensity. The default 
scheme is the ‘rainbow’ spectrum, with low intensity toward the violet and 
high intensity toward the red. White indicates a saturation condition. If the 
beam is too intense and saturation is observed, attenuation will be needed. 
To fully utilize the system dynamic range and achieve the specified accuracy 
in beam measurements, adjust the laser intensity to a level just below the 
saturation level. 

4.1.3. Trigger Mode for Pulsed Lasers 
If your laser is CW, skip this step. 

To measure pulsed laser beams, use either the External Trigger Mode or the 
Pulsed Trigger Mode. These trigger modes are discussed below. 

If you can provide an external trigger, the best way to measure pulsed laser 
beams is using the External Trigger Mode. External triggering requires a 
TTL signal, with the trigger occurring on the positive-going (leading) edge. 
The external trigger cable provided with the system connects to the camera 
with a Hirose connector and has a BNC connector for the TTL signal input. 

The External Trigger acts like an Asynchronous Reset for the camera 
integration or exposure period. It is therefore necessary to apply the trigger 
before the occurrence of the laser pulse, or in other words it requires a 
PRETRIGGER signal. The trigger occurs on the positive-going (leading) 
edge of the  signal, and this must occur at least 32µs for model 2512 and at 
least 63.5µs for model 2523 before the laser pulse.  

If you cannot provide an external trigger, use the Pulsed Trigger Mode. 
When this mode is selected, the software will automatically determine the 
presence of the beam based on minimum signal amplitude of 32 counts out 
of 4096. In this mode, the update rate will, in general, be reduced from that 
obtainable using the External Trigger Mode. The Trigger Mode can be 
changed through the Data Collection menu using the mouse. Open the 
Trigger Mode menu and select either Pulsed or External. 
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4.1.4. Calibrate the System 
It is necessary to perform a calibration prior to making beam measurements 
to obtain the specified accuracy. To calibrate, select Calibration from the 
Data Collection menu. The Camera Calibration dialog box will appear. 

There are 2 visual indicators in the GUI, which change depending on the 
system calibration status. These indicators are the Calibration icon on the 
main toolbar and the status bar. The icons change to indicate the status of 
calibration, as follows: 

 
System Uncalibrated 

 
System Settings Changed since last calibration 

 
System Calibrated under current system settings 

System settings include camera gain and exposure, trigger mode, and unit 
serial number. 

The status bar changes color to indicate the status of calibration. RREEDD 
indicates an uncalibrated system, YYEELLLLOOWW  indicates that the system has 
been calibrated, but that something about the measurement configuration 
has changed; either the exposure or gain, the trigger mode, or the unit serial 
number. In this case it is recommended to recalibrate. If the status bar has 
the default color, the system is calibrated under the current measurement 
configuration. 

To calibrate, use the displayed Calibrate icon,    on the main 
toolbar or select Calibration from the Data Collection menu. The Camera 
Calibration dialog box will appear. 
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Simply follow the directions. Block the beam (as far from the camera aperture 
as possible) and click the Calibrate button. Then click on the OK button. This 
completes the calibration procedure. 

4.1.5. Switch to Analysis Mode 
To start measuring Beam Parameters, the system must be set to Analysis 
Mode. The Analysis Mode can be set by selecting Acquisition Mode from 
the Data Collection menu and clicking on Analysis. 

 

Alternatively, use the  icon on the toolbar. 

4.1.6. Beam Parameters – Computation and Display 
4.1.6.1. Computation of Parameters 
Beam parameters are computed when the system is operating in the 
Analysis Acquisition Mode. The computations that are performed are 
determined by selections made in the Data Analysis dialog. To optimize the 
data update rate, all computations are done on a subset of the entire video 
image called the Beam Area. The computations also use the effective pixel 
dimensions and the Magnification Factor. 

4.1.6.2. Beam Area 
If the system is set for Auto Track, the Beam Area is automatically 
determined to include the entire laser beam image but to be of minimal size. 
(This is to minimize the computation time by keeping the Beam Area as small 
as possible.) If the system is not set for Auto Track, a Beam Area must be 
set manually so that computations are performed. To set the Beam Area 
manually, either use the Set Beam Area selection under the Video window 
Options menu, or use the Set Beam Area drawing tool on the Video window 
toolbar. The Beam Area-Position/Size dialog box can also be used to define 
the top, left, width and height coordinates.  

4.1.6.3. Magnification Factor 
This item under the Data Collection menu opens a dialog box for entering 
an optical magnification factor. This is necessary to obtain accurate beam 
width values whenever optical components such as lenses or mirrors with 
magnification are used to image a laser beam. This factor is used to scale 
the linear pixel dimension of the camera selected for measurements. The 
default magnification factor is 1. (If you do not know the magnification factor 
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of your optical system, it can be determined by mechanically translating an 
object a known distance horizontally through the image. The measured 
translation of the object in the image divided by the known mechanical 
translation is the magnification factor.)  

4.1.6.4. Displaying Parameters 
Computed parameters can be displayed in the Beam Statistics window or in 
the Time Statistics windows. The selection of parameters for display is 
accomplished through the Parameters entry under the Options menus for 
these windows. Selecting the Parameters entry opens a dialog box for 
specifying which parameters will be displayed. 

4.2. Advanced Use 
The previous Quick-Start procedure utilizes only the very basic features of 
the FireWire BeamPro Acquisition and Analysis Software program. The 
program is very powerful and flexible, allowing users to configure the image 
data acquisition, the analyses, and the information display windows to suit 
their individual needs.  

The Data Collection menu includes selections that determine or affect the 
collection of data. Through the Data Analysis dialog, users select the types 
of data analyses that will be performed, all in accordance with the ISO 
Standards.  

Numerous parameters can be computed and displayed, determined in the 
Beam Statistics Parameters dialog. Parameters measured include: 

♦♦  Beam width 
♦♦  Centroid and peak location 
♦♦  Major and minor axes 
♦♦  Beam orientation 
♦♦  Ellipticity, eccentricity 
♦♦  Gaussian fit 
♦♦  Beam uniformity 
♦♦  Beam divergence 
♦♦  Pointing stability 
♦♦  M², K-factor 
♦♦  ISO 11146 M² parameters (Available only with the ModeScan 

Model 1780) 

Three methods for computing beam widths: Dslit, Denergy, or D4σ, are available 
in either XY or Elliptical analysis modes. 
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Energy/Power Uniformity or Flat Top analyses can be performed on 
selected regions of interest.  

There are also three methods of computing Beam Divergence. 

Windows available for display include the: 

♦♦  Video window;  
♦♦   Profile window; 
♦♦  2D Contour window; 
♦♦  3D Profile window;  
♦♦  Beam Statistics window;  
♦♦  Time Statistics window; 
♦♦  Pointing window; 
♦♦  K-Factor window; 
♦♦  Measurement window (available only with the ModeScan 

Model 1780). 

Each window has an Options menu that offers many choices in how data will 
be displayed. There is also a Notes window for entering text. Users can 
arrange and size multiple windows as required, and these screens can be 
saved as files for future use. Limit Analyses can be performed on selected 
beam parameters. Also, data can be exported to spreadsheets, math and 
statistical analysis programs, and process/ instrumentation programs by 
logging data to files or COM ports, or shared using ActiveX Automation. 

A complete description of the various features of the program is given in this 
section. Users are encouraged to learn the software features in detail and to 
experiment with the program. A little time spent in advance learning the 
features of the system will go a long way in making the FireWire BeamPro 
Acquisition and Analysis System an invaluable resource for laser beam 
characterization. 

4.3. Operating Hints 
1. Use the manual to completely familiarize yourself with all the 

features of the FireWire BeamPro Acquisition and Analysis 
Software. 

2. Use Laser Positioning mode for positioning the laser beam 
in the aperture, and also for course tuning of the laser beam. 
Only use Analysis mode when you need parameter values. 

3. Configure the Data Analysis and Beam Statistics 
Parameters only for values that are needed. For example, do 
not use Elliptical Analysis if the laser beam is nearly circular. 
Additional computations require more time and reduce the 
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system performance in terms of data update rate and the 
cross hairs will be very unstable, constantly jumping around to 
find the “ellipse”. 

4. Calibrate the system periodically. Array sensors are very 
sensitive and can sense changes in background light intensity 
due to such things as reflections from a white shirt or light 
from a computer monitor. For accurate and repeatable 
measurements, the consistency of the experimental setup is 
important. Therefore, calibrate the system whenever there is 
a change in setup or background lighting. This will ensure the 
most consistent and accurate results.  

5. Open only those windows that are required by your 
application. Additional windows reduce the data update rate. 
This is particularly true for the Video, 2D Contour, and  
3D Profile windows. If all you need is beam width values, and 
you require the fastest data update rate, close unnecessary 
windows, including the Video window, and use only the Beam 
Statistics and/or Time Statistics windows. 

6. Every window has a display update rate that is configured 
under the Options menu for each window. You may want to 
change the default Timing settings in order to improve the 
performance of your system. 

7. Use Autotracking if your beam is stable. If your beam is 
unstable, the Beam Area as defined by the Autotracking 
algorithm will also be unstable. This will adversely affect the 
Profile and 3D Profile windows, in that the displays will tend 
to change or pop with each change in the Beam Area. In this 
case, set a manual Beam Area to eliminate these effects. 

8. Use Frame Background Subtraction to eliminate any stray 
light that is not due to the incident laser beam. 

9. If data is being collected over long periods of time, use the 
Automatic backup feature to prevent total loss of data in the 
event of a failure. 
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4.4. Program Menus 

4.4.1. File Menu 
As in any other Windows compliant program, the File menu is used for file 
manipulation and printing.  

When File on the Menu Bar is clicked, the pull-down menu below appears. 

 
New Closes all open windows, and then creates a 

new Video window. 

Open… Opens the File Open dialog box. It lists Data 
Files from the current working directory. 

 To open a data file, select one from the list and 
then select the Open button. All windows will be 
closed and the new file will be loaded. The data, 
windows and computed statistics from the file 
will be displayed. 

 To open a configuration file, repeat the above 
steps except select Configuration Files from 
the Files of Type combo box. The list will show 
all configuration files in the current working 
directory. Configuration files contain everything 
that a data file does, except for the raw data and 
beam statistics. Use this to save a particular 
screen layout and set of data acquisition 
parameters without the raw and computed data. 

Close Closes all open windows and halts data 
collection.  
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Save Saves the current data and windows 
configuration in the currently active file. The 
name of this file is displayed on the main window 
title bar. 

Save As… Opens the File Save As dialog box. It lists Data 
Files from the current working directory. Either 
select an existing file from the list or enter a new 
name in the File Name edit box. To save as a 
data file, simply select the Save button. There 
are 5 different file types, identified by their 
extensions: 

 *.fwd Data File: Includes screen configuration and 
associated image and computed data. Only the 
FireWire BeamPro Acquisition and Analysis 
Software can use this file. 

 *.fwc Configuration File: Includes screen configuration 
only. Only the FireWire BeamPro Acquisition and 
Analysis Software can use this file. 

*.prw Frame Data – Raw File: Includes raw image data 
only. The Frame Data File is a binary file. It 
contains the number of columns and rows, 
saved as unsigned short (16-bit unsigned), then 
each pixel of the frame as an unsigned short 
(16-bit unsigned). The pixels are saved line by 
line, starting with the top line. This file cannot be 
read back by FireWire BeamPro Acquisition and 
Analysis Software. 

*.tif Frame Data – TIFF File. Saves the current frame 
(raw image) as uncompressed 16-Bit TIFF 
image. 

 *.asc ASCII File. Saves data displayed in all open 
views in ASCII format. 

 IMAGE Saves the program screen as an IMAGE file, 
either BMP, JPEG, GIF, TIFF, or PNG File. This 
is used for exporting graphics into documents 
and reports. The IMAGE file format is selected 
under Image Settings dialog in the File menu 
Preferences item.  
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Preferences 

 
 Timed Backup Opens the Automatic Data Backup dialog box. 

If the Backup On checkbox is selected, then all 
data will be saved automatically at the specified 
interval. Use this feature when collecting data 
over extended periods to prevent data loss in the 
event of a power outage or other catastrophe. 
When the program is restarted after such an 
event, the backup file will load and data 
collection resumes from the point of the last 
automatic save. 

 

 
 On Power Up Opens a menu with the following selections: 

 

 
 Load Previous 

Setup 
When checked, the last data file will 
automatically load at startup. 

 Global Collect 
On 

When checked, data collection resumes at 
startup. 

 On Exit Opens a menu with the following selections: 

 
 Save Setup When checked, the Save As dialog box appears, 

prompting the user to save the latest data. 

 Prompt When checked, the user is prompted with an 
Leaving Already? dialog upon exit. 

Background Logo When checked, the Photon Logo appears as the 
background for the main window. 
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Image Settings… Opens a dialog box for selecting the image 
export format for the active window and the full 
screen. Available choices for Image Format are: 

 BMP Windows Bitmap 

 JPEG JPEG File Interchange Format (JFIF) 

 GIF Graphics Interchange Format 

 TIFF Tagged Image File Format 

 PNG Portable Network Graphics 

 This dialog is also used to set the image 
compression for JPEG Files. 

 
Print… Prints a picture of all open windows to the 

currently selected default printer. The user may 
change this printer from the Print dialog if 
desired. 

Print Setup… Opens a dialog box for selecting and configuring 
printers 

Exit Exits the program. 

4.4.2. Edit Menu 
When Edit on the Menu Bar is clicked, the pull-down menu below appears: 

 

 
Copy Copies the current window to the Windows 

clipboard as a bitmap image and/or text, 
depending on the active view. From there, the 
information can be pasted into other program 
applications. 
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Export… Opens the File Save As dialog box for exporting 
the active window as an image file, either BMP, 
JPEG, GIF, TIFF or PNG, used for exporting 
graphics into documents and reports. The image 
file format is selected under Image Settings 
dialog in the File menu, Preferences item. 

4.4.3. View Menu 

When View on the Menu Bar is clicked, the pull-down menu below appears: 

 

 
Main Toolbar When checked, the toolbar on the main window 

is visible. 

Local Toolbar When checked, the toolbar of the currently active 
view is visible, if available. 

Status Bar When checked, the status bar at the bottom of 
the main window is visible. 

4.4.4. Options Menu 
There are various options associated with each window. These are selected 
in the Options menu. When a particular window is selected or active, the 
various options associated with that window are listed in the Options menu. 
The list of options is unique for each window. The options list for each 
window can be found below, under the window descriptions.  
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4.4.5. Data Collection Menu 
The Data Collection menu includes selections that determine or affect the 
collection of data. When Data Collection on the Menu Bar is clicked, the 
pull-down menu below appears: 

 

 

Global Data Collection Enables data collection and updates for all 
windows. 

Auto Track Selects the autotracking feature, which 
automatically locates and tracks the laser beam 
and defines an optimal region, called the Beam 
Area, for performing data analysis. 
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Acquisition Mode Opens a menu for selecting the acquisition mode:  

 
Choices are: 

 Laser Positioning Captures and displays images in the Video 
window. No calculations are performed, thus 
providing the fastest update rate. This mode is 
intended for setup prior to acquiring quantitative 
data. Use this mode for positioning your laser in 
the sensor aperture, adjusting attenuation, or for 
visually tuning the laser. 

 Analysis Enables data analysis computations.  

 Single Shot Enables single shot acquisition and analysis. One 
frame is acquired and processed each time the 
user selects the Global Data Collection in the Data 
Collection menu or, alternatively, after clicking the 
Global Data Collection icon on the toolbar. 

 Multiple Samples… Enables the multiple samples acquisition mode. 
Sequential samples are acquired and stored for 
later playback and analysis. 

The maximum number of samples cannot exceed 
512 and depends on the video format and the 
available space on the hard drive.  
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Samples to be 
Acquired 

Select the desired number of samples to be 
acquired in the edit box (or by using the attached 
spin control). 

Acquire Multiple 
Samples 

Start the sequential acquisition. During the 
acquisition process the progress bar will indicate 
how many frames were already acquired. Once 
the acquisition process is done, the software will 
return full control to the user. 

 

Cancel 
Acquisition 

Cancels the multiple acquisition process and 
return full control of the software to the user. All 
the samples already acquired will be available for 
display and analysis. 

Replay Replay the acquired samples. The sample number 
from where the replay begins can be selected by 
entering this number in the Sample # dialog box. 
All the BeamPro analysis features are available in 
the replay mode. 

Stop Stop the replay sequence. 

Replay Timing Opens a dialog box for selecting the replay update 
rate. 

 First: displays the first acquired sample in the 
sequence. 

 Previous: displays the previous sample in the 
sequence. 

 Next: displays the next sample in the sequence. 
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 Last: displays the last acquired sample in the 
sequence. 

Sample # Enter the sample number to be displayed, deleted 
or used as start for replay. 

Delete Deletes the sample selected in the Sample # 
dialog box. When a sample is deleted, all other 
samples keep their initial index value. 

Close Close the Acquire Multiple Samples dialog box. 

Trigger Mode Opens a menu for selecting 1 of 3 trigger modes. 

 

Choices are: 

 CW Captures and displays images continuously. Use 
this mode when measuring CW laser beams. 

 Pulsed Captures and displays good images continuously. 
Use this mode when measuring pulsed lasers 
where external triggering is not available. In this 
mode the software rejects invalid frames. 

 External Captures and displays images whenever an 
external trigger pulse is detected. Use this mode 
when measuring pulsed lasers where external 
triggering is available. In this mode the software 
rejects invalid frames. This is the best mode for 
your pulsed laser. 

Averaging… Opens a dialog box for setting the number of 
frames to average. Entire frames are sequentially 
added up to the set value and then divided by the 
number of frames to obtain an average frame. 
This is not a rolling average; therefore, setting this 
number higher will slow the update rate 
significantly. 
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Image Flip Opens a menu for selecting the orientation of the 
image with respect to Vertical and Horizontal. Select 
None to display the original frame, Horizontal to flip 
the image about the horizontal axis, Vertical to flip 
the image about the Vertical axis. This operation 
takes precedence over Image Rotation. 

 
Image Rotation Opens a menu for selecting rotation of the image. 

Select 0° to display the original frame, or 90°, 180°, 
270° to rotate the image in clockwise direction. 

 
Camera Selection… Opens the Camera Selection dialog for selecting 

FireWire BeamPro cameras for use by Model and 
Serial Number. When a new camera is selected 
the system will not be calibrated and the data 
collection would be turned off. 
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Camera Settings… Opens the Camera Settings dialog for setting the 
camera Gain and Exposure Time. The Gain 
ranges from 0 to 12 dB for Models 2512 and 2523 
and from 0 to 7 dB for Model 2518, while the 
exposure ranges between 20µs and 81.9ms for 
Models 2518 and 2523 and between 20µs and 
27.52ms for Model 2512. The gain increment is 
1dB, while the exposure increment is 0.02ms 
(20µs). The selected gain and exposure time are 
displayed on the edit box placed on the left side of 
the corresponding slider. 

 
 Auto Initiates a one-shot automatic setting of exposure 

and gain. The target amplitude is 90-95% full 
scale. Exposure is adjusted first and then gain. 

Auto Settings Initiates a one-shot automatic setting of exposure 
and gain. The target amplitude is 90-95% full 
scale. Exposure is adjusted first and then gain. 
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Track Settings Enables continuous automatic setting of exposure 
and gain to maintain peak amplitude at 90-95% full 
scale. This option is currently unavailable. 

Peak Gauge… Opens the Peak dialog, showing the status of the 
peak signal amplitude of the beam profile in the 
entire camera frame. All 5 conditions of the dialog 
are shown below. The dialog includes a level 
indicator and uses colorization to display status 
near saturation and “no beam” conditions. The “No 
Beam” condition corresponds to a level below 32 
counts, and is indicated by “red” in the box at the 
bottom. Above 32 counts the box changes in color 
to yellow, and stays yellow up to 400 counts, at 
which point it changes to “green”. (400 counts is 
the minimum amplitude at which the beam 
diameter accuracy is within the specification of 
±2% for a 64µm beam.) For saturation, the top box 
is green if the amplitude is below 4000 counts, 
changing to “yellow” above 4000 counts and to 
“red” at 4095 counts. The blue level indicator is a 
linear display of the signal amplitude from 0-4095 
counts. Generally, for a good measurement the 
color indicators should be all green. 

     
Peak Gauge (M²)… This option is available only with the ModeScan 

Model 1780 system. 
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Calibration…  Opens the Calibration dialog for performing a 
background calibration of the camera. The info 
field displays the date and the time of the last 
calibration. If the camera was not calibrated the 
message “The system is not currently calibrated.” 
is displayed. 

To perform a calibration, simply follow the 
instructions in the dialog box. First, block the laser 
beam (as far from the camera aperture as 
possible). Then click on the Calibrate button. The 
calibration is complete when the OK button 
becomes active. The current date and time will be 
displayed in the info field. Then click on the OK 
button to exit the Calibration dialog.  

 

Background Correction Opens a menu for selecting the method of 
background correction. The available choices are: 

 
 Frame Selects the background frame correction method. 

The background frame values are subtracted from 
each data frame on a pixel-by-pixel basis. 

 Mean Selects the background mean value correction 
method. The mean value of the background frame 
is subtracted from each pixel value in the data 
frame. 

 None Selects no background correction. 
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Data Analysis… Opens the Data Analysis dialog for selecting the 
calculations to be performed on each data frame. 

 
The various selection choices are: 

 Beam Propagation Selects the Beam Propagation Analysis mode, 
available only with the ModeScan Model 1780 
system. 

 ISO Profiles Selects the method of ISO Profiles beam width 
computation. Choose from 1 of 3 possible 
selections: 

  D slit Selects the slit method for determining beam widths. 
The computation simulates a scanning slit aperture 
with slit width equal to the effective pixel dimension 
of the camera used for measurement. Scans are 
performed along the horizontal and vertical 
directions or along the directions of the major and 
minor axes if elliptical analysis is selected. 

  D energy Selects the encircled energy method for 
determining beam widths. The computation 
simulates circular apertures centered at the laser 
beam centroid and calculates the energy through 
the aperture. The diameter of the circular aperture 
is increased until the specified energy percentage 
is obtained. 

  D 4sigma Selects the second moment method for 
determining beam widths. The computation 
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determines the second moment of the laser beam 
distribution. 

 Elliptical Analysis By default, data analysis is performed along the 
horizontal and vertical directions of the pixel array. 
If the Elliptical Analysis box is checked, the 
analysis will be performed along the directions of 
the major and minor axes of the beam. 

 Gaussian Fit:  To enable Gaussian fit calculations of the profiles 
displayed in the Profile window (either Slit or 
Pinhole scans), check the box labeled Gaussian 
Fit. The Gaussian fit to the profiles can then be 
displayed as overlays on the profiles in the Profile 
window by selecting the Fit option for that window. 
The corresponding Gaussian Goodness-of-Fit 
parameter can be displayed in the Beam 
Statistics Parameters or the Time Statistics 
window.  

 Flat Top Analysis Enables Uniformity or Flat Top Analysis of 
Energy Region of Interest (ROI). The Energy ROI 
is a user-defined region in the Video window. 

  Threshold (%) Defines the threshold as a percentage of the peak 
pixel value for which the Flat Top Analysis will be 
performed. Only those pixels in the Energy ROI 
that are greater than this value are included in the 
analysis. 

 Energy When selected, the total energy or power in the 
Beam Area is computed. In addition, the energy or 
power in the Energy ROI and the percentage of 
the energy in the Beam Area are computed in the 
Flat Top Analysis, if enabled. Also, the Min, 
Mean, and Max values in the Flat Top Analysis 
will be reported as Fluence or Irradiance per pixel. 

 Divergence Selects the method for divergence computation. 
Choose from 1 of 4 possible selections: 

  Off No divergence computations will be made 

  Lens Selects the Lens method for computing 
divergence. When selected, the lens focal length, 
in millimeters, and the beam width clip level 
percentage must be specified.  
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  Point Source Selects the Point Source method for computing 
divergence. When selected, the distance from the 
point source to the measurement plane, in 
millimeters, and the beam width clip level 
percentage must be specified.  

  Numerical 
Aperture 

Selects the Numerical Aperture method for 
computing divergence. When selected, the 
distance from the point source to the 
measurement plane, in millimeters, and the beam 
width clip level percentage must be specified. The 
numerical aperture equivalent of the divergence 
half-angle is reported ( ( )2sin θ ). 

Energy Calibration… Opens the Energy Calibration dialog for entering 
calibration reference records and for selecting the 
calibration reference record for use. When the first 
calibration file has been added, it will display as 
the default and the box will be checked. With 
multiple calibrations, set the default calibration by 
checking the desired checkbox. The listed records 
will be saved with the FireWire BeamPro data file 
if it is saved. The records can also be saved as 
separate calibration record files using the Save 
feature described below. 

 

Descriptor Text Field for entering Calibration information. 
Maximum 256 characters. 

Reference Energy Numeric Field for entering the Calibration 
Reference Energy/Power obtained from 
independent measurements of the beam with an 
energy or power meter. Values between 1 and 
1000  are allowed. Units are selected in the Units 
Combo Box. 

Units Combo Box for setting the units of Energy/Power. 
Units range from J to pJ or W to pW. 
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Calibrate Initiates the Calibration Procedure. At least one of 
the calibration text fields must be different from the 
previous calibration. There should be a calibration 
for each type of laser to be measured. The power 
meter is a relative meter and must be calibrated to 
a known source for each wavelength and power 
range to be measured. 

Delete Deletes the selected Calibration. 

Load… Opens a dialog for selecting files containing 
calibration reference records. When the file is 
loaded all previously listed records in the Energy 
Calibration Dialog are deleted. 

Save… Opens a dialog for selecting the name and path for 
the file that contains calibration reference records. 

Beam Propagation… Opens a dialog box for entering the parameters for 
M² measurement, available only with the Model 
1780 ModeScan. 

Magnification Factor… Opens a dialog box for entering an optical 
magnification factor that will scale the camera pixel 
dimension. This is necessary to obtain accurate 
beam width values whenever optical components 
such as lenses or mirrors with magnification are 
used to image a laser beam. It allows 
compensation of any optical or imaging schemes 
that change the size of the beam image. This factor 
is used to scale the linear pixel dimension of the 
camera selected for measurements. The default 
magnification factor is 1. 

 
Angle Units Opens a menu for selecting the units used for 

reporting all the angles, either milliradians or 
degrees. 

Recompute Click on Recompute to redo computations on the 
image data currently in memory. Use this feature if 
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any changes to the analysis are desired, e.g., 
changing the method of beam width computation, 
or changing the Beam Area or the Energy ROI to 
analyze a different region of the image. 

Reset All Views Resets all open data-display windows. 

Settings Status… Opens the Settings Status screen dialog, which 
displays the current program settings. 
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4.4.6. Window Menu 

When Window on the Menu Bar is clicked, the pull-down menu below appears.  

  

The Window menu is used to open new windows, arrange windows and 
window icons and to close all open windows. The list at the bottom of the menu 
shows which windows are open with the currently active window checked. 

New Windows Opens a menu for selecting windows for 
viewing. 

 
Cascade Arranges the open windows in cascade format. 

Tile Arranges the open windows in tile format. 

Arrange Icons Arranges the minimized window as icons on 
the bottom of the main window. 

Close All Closes all open windows. 

Window List Displays a list of all open windows and displays 
a check before the currently active window 
name. 
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4.4.7. Help Menu 

Use the Help menu to access Help Topics, and the About FireWire 
BeamPro dialog box. Help Topics is currently unavailable. 

  

4.5. Window Descriptions 

4.5.1. Profile 

 

The Profile window displays either Pinhole or equivalent Slit profiles in 
orthogonal directions along the crosshairs displayed in the live Video 
window. An example of the Profile window is given above. If data analysis is 
set to the default XY mode, then the profile axes are horizontal and vertical. If 
data analysis is set to Elliptical Analysis Mode, then the profile axes are 
oriented along the major and minor axes of the laser beam image. 
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The locations of the Pinhole profiles are identified by the crosshairs in the 
Video window. The pinhole profile locations can be selected to be through 
either the beam centroid, the peak pixel, or through user selected points by 
dragging the crosshairs with the mouse to the desired location. Also, when in 
elliptical analysis mode, the orientation of the axes can be changed arbitrarily 
by holding down the control key and using the mouse to rotate the axes. 

For Slit profiles the crosshairs identify the direction of the equivalent slit scan.  

The Options menu available when the Profile window is active is shown 
below. 

  
The selections are: 

Data Collection Turns data collection on/off. 

Timing… Opens a dialog box for selection of the profile 
update rate. 

 
Fit Places a blue-colored Gaussian fit overlay on the 

profiles if Gaussian Fit 1D is enabled in the Data 
Analysis dialog box. 

Normalize Scales the profile amplitude to have a peak value 
of 1, i.e. full scale. 

Profile Selects either the Pinhole or the Slit profiles for 
display. 
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Scale Allows the user to choose between a Linear and 
a Logarithmic scale. 

 
These options can also be selected using the Profile window toolbar: 

 

 Starts data collection. 

 Stops data collection. 

  Turns Gaussian Fit overlay on/off. 

 Turns Normalization on/off. 

4.5.2. Video 
The Video window displays the video laser image. An example of the Video 
window is given below. 

 
The crosshairs in the image identify the location and/or direction of profiles 
displayed in the Profile window, depending on the type of profile selected, 
either Pinhole or Slit, in the Profile options. If data analysis is set to the 
default XY mode, then the profile axes are horizontal and vertical. If data 
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analysis is set to elliptical mode, then the profile axes are oriented along the 
major and minor axes of the laser beam image. 
For Pinhole profiles the pinhole profile locations can be selected to be 
through either the beam centroid, the peak pixel, or through user selected 
points by dragging the crosshairs with the mouse to the desired location. 
Also, when in elliptical analysis mode, the orientation of the axes can be 
changed arbitrarily by holding down the control key and using the mouse to 
rotate the axes. 
For Slit profiles the crosshairs identify the direction of equivalent slit profiles. 

The Options menu available when the Video window is active is also shown 
below. 

 

The selections are: 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 
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Select Colors… Opens a dialog box for selection of the display 
color scheme. Choices available are: Rainbow, 
Gray, Red, Green and Blue. 

 
View Finder Opens a display box that shows the entire 

camera video image. 

 
Zoom Factor Opens a menu for selecting the zoom factor. 

Choices available are: 1:2×, 1×, 2×, 4×, 8×, 16×, 
and Fit to Window proportional to the camera 
array dimension. 

 
Auto Position When auto position is selected the laser beam 

image will automatically be positioned in the 
displayed portion of the Video window. 
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Overlays Opens a menu for selecting which overlays will be 
displayed in the Video window.  

 
Choices available are: 

 Cross Hairs Selecting Cross Hairs opens a second menu 
with the following choices: 

 
The selection is available only if the Pinhole is 
selected under the Profile option in the Profile 
Window. When the Profile display is set to Slit, 
the Cross Hairs are drawn through the centroid 
and cannot be moved, so no other selections can 
be made. 

  Off Turns the cross hair overlay off. 

  Centroid Places the cross hairs at the centroid. 

  Peak Places the cross hairs at the peak. 

  User Defined Allows the cross hairs to be positioned manually 
at an arbitrary position using the mouse. 

 Beam Area Turns the Beam Area overlay off or on. 

 Energy ROI Turns the Energy ROI overlay off or on if Flat 
Top Analysis is enabled. 

Set Beam Area  Allows the user to set a Beam Area manually. 

The beam area can be defined/adjusted using 
the mouse or defining the top, left, width and 
height coordinates.  
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 To set Beam Area 
using the mouse: 

First click on Set Beam Area. Next, use the 
mouse to draw and/or adjust the desired beam 
area in the Video window. Finally, click on Set 
Beam Area a second time to validate the Beam 
Area previously drawn. In drawing/adjusting 
mode, depress ESC to discard all the changes 
and revert Beam Area to its original size and 
position. 

Note: Selecting the Set Beam Area will also 
open (or close) the Beam Area–Position/Size 
dialog box. 

 To set Beam Area 
using coordinates: 

Click on Set Beam Area. In the Beam Area–
Position/Size dialog box, enter the Top, Left, 
Width and Height coordinates in the designated 
edit boxes.  

 
  Redraw Redraws the beam area based on the new 

coordinates and keep the Beam Area-
Position/Size dialog box open. 

  Close Closes the dialog box. 

  Cancel Ignores any changes made during the 
drawing/adjusting mode, reverts Beam Area to its 
original size and position and closes the dialog 
box. 

Set Energy ROI  Allows the user to set the Energy ROI manually. 
The ROI can only be drawn inside the Beam 
Area. The ROI can be defined/adjusted using the 
mouse or defining its coordinates.  

Note: Flat Top Analysis (from Data Collection 
menu, Data Analysis dialog) must be enabled for 
the ROIs to be available. 
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To set Energy ROI using the mouse: 

 First click on Set Energy ROI; this opens a 
second menu with the following selection 
choices. Rectangle, Square, Elliptic, and 
Circle. Click on one of these to determine the 
general shape of the Energy ROI to be drawn. 
Next, use the mouse to draw and/or adjust the 
desired Energy ROI in the Video window. Finally, 
click on the shape selection a second time to 
validate the Energy ROI previously drawn. In 
drawing / adjusting mode, depress ESC to 
discard all the changes and revert Energy ROI to 
its original size and position. 

Note: Selecting the one of the Set Energy ROI 
item will also open (or close) the corresponding 
Energy ROI – Position/Size dialog box. 

To set Energy ROI using coordinates: 

 Click on Set Energy ROI; this opens a second 
menu with the following selection choices. 
Rectangle, Square, Elliptic, and Circle. Click 
on one of these to determine the general shape 
of the Energy ROI to be drawn.. 

 Rectangle: Enter the Left, Top, Width and Height 
coordinates for the Rectangle Energy ROI. 

 
 Square: Enter the Left, Top coordinates and the Size for 

the Square Energy ROI. 
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 Elliptic: Enter the Left, Top coordinates and the 
Horizontal Axis and Vertical Axis for the 
Elliptical Energy ROI. 

 
 Circle: Enter the Left, Top coordinates and the 

Diameter of the Circle Energy ROI. 

 
  Redraw  Redraws the beam area based on the new 

coordinates and keep the Energy ROI-
Position/ Size dialog box open. 

  Close Closes the dialog box. 

  Cancel Ignores any changes made during the 
drawing/adjusting mode, reverts Energy ROI to 
its original size and position and closes the 
dialog box. 

Record (AVI) Turns the video record mode on or off, for 
recording live video sequences of laser beam 
profile images. When turned on a Save As 
dialog appears for entering the name of the AVI 
file. The maximum number of frames that can 
be stored in a file is 512. The AVI files cannot be 
played back in the software. 
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The Beam Area and Energy ROI setting tools can also be accessed on the 
Video window toolbar: (Note: The Energy ROI tools are available only if Flat 
Top Analysis is enabled.) 

 

 Set Beam Area. 

 Energy ROI: Elliptical 

 Energy ROI: Circular 

 Energy ROI: Rectangular 

 Energy ROI: Square 

4.5.3. 3D Profile 

The 3D Profile window displays the laser beam image in a ‘3-dimensional’ 
viewing format. The laser beam image can be rendered with either a 
wireframe or solid surface, with user selected clip levels and colors.  
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The Options menu available when the 3D Profile window is active is shown 
below. 

  
The selections are: 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 
Clip Level… Opens a dialog for selecting clip level contours 

and their colors. 

 
This option is not available for data displayed 
using the logarithmic scale. In this case, the 
contour levels are fixed at the 0, -3, -5, -10, 
-13, -20, -23, -30, and the -33 dB levels. 
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Clip Legend When selected, the Clip Level legend will be 
displayed in the view. 

Fill Contours When selected, the different clip levels on the 
beam will be clearly delineated. Please be 
aware that this option will slow the acquisition 
rate of the system. 

Solid Surface When selected, the image will have a solid 
surface. When not selected, the image will be 
rendered as a wireframe. 

Resolution Opens a menu for selecting the resolution of 
the 3D display. Choices are: High, Medium, 
and Low. Data update rate is reduced and 
image  
manipulation is slower as resolution is 
increased. 

 
Scale Allows the user to choose between a Linear 

and a Logarithmic scale. 

 

The toolbar at the right border of the window contains 8 buttons used to 
select several viewing and image manipulation features. These buttons are, 
from top to bottom: 

 
Chooses the Arrow cursor, which allows image 
manipulation only using the mouse and the 
thumbwheel controls. 

 
Chooses the Hand cursor, which allows 
image manipulation using the mouse 
directly in the image or by using the 
thumbwheel controls. (When the mouse 
is moved to the window border the Hand 
cursor changes to the Arrow cursor). 

 
This Help menu is inactive. 

 
Resets the view to a preset Home default 
position, size and orientation. 
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Sets the default settings for the Home button. 

 
Restores the view to include the entire image. 

 
Activates the Seek cursor. After positioning this 
cursor on a selected point in the image and 
clicking the left mouse button, a close-up zoom to 
that point will be performed automatically. Also, 
the center of rotation will be set to that point. 

 ,   
Toggles between the Perspective and 
Orthographic projection modes. 

 
There are also three thumbwheels along the 
window border, designated Dolly, Rotx, and Roty, 
which are used to zoom and rotate the 2D image. 

The image can be rotated, translated, panned, and zoomed using the mouse 
with the Arrow cursor and the thumbwheel control knobs or using the mouse 
with the Hand cursor, as described below. 

Rotation Rotate the image using the mouse and the 
Arrow cursor with the thumbwheels labeled 
Rotx and Roty. Alternatively, use the mouse 
and the Hand cursor to directly rotate the 
image; Position the hand cursor over the image, 
depress the left mouse button, and drag the 
mouse to obtain the desired orientation. 

Pan/Translate While depressing the control key <CTRL>, use 
the mouse and the Hand cursor to directly pan 
the image. Position the hand cursor over the 
image, depress the left mouse button, depress 
the control key, and drag the mouse to move 
the image to the desired location. 

Zoom The method for zooming the image depends on 
the type of display projection selected. In the 
Perspective projection mode, use either the 
zoom control scroll bar at the bottom of the 
window, or use the Dolly thumbwheel at the 
lower right border of the window. In the 
Orthographic projection mode, use the Zoom 
thumbwheel at the lower right border of the 
window. You can also zoom by using the 
mouse. To zoom in (out) hold the Ctrl+Shift keys 
down and drag the mouse toward (away from) 
the center while holding the left mouse button. 
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4.5.4. 2D Contour 
The 2D Contour window displays the laser beam image with user specified 
contour overlays. An example of the 2D Contour window is shown below. 

 
The Options menu available when the 2D Contour window is active is 
shown below. 
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The selections are: 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 
Clip Level… Opens a dialog for selecting clip level contours 

and their colors. 

 
This option is not available for data displayed 
using the logarithmic scale. In this case, the 
contour levels are fixed at the 0, -3, -5, -10, -13, 
-20, -23, -30, and the -33 dB levels. 

Clip Legend When selected, the Clip Level legend will be 
displayed in the view. 

Fill Contours When selected, the different clip levels on the 
beam will be clearly delineated. Please be 
aware that this option will slow the acquisition 
rate of the system. 

Solid Surface When selected, the image will have a solid 
surface. When not selected, the image will be 
rendered as a wireframe. 
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Resolution Opens a menu for selecting the resolution of the 
3D display. Choices are: High, Medium, and 
Low. Data update rate is reduced and image 
manipulation is slower as resolution is 
increased. 

 
Scale Allows the user to choose between a Linear 

and a Logarithmic scale. 

 
The toolbar at the right border of the window contains 8 buttons used to 
select several viewing and image manipulation features. These buttons are, 
from top to bottom: 

 
Chooses the Arrow cursor, which allows image 
manipulation only using the mouse and the 
thumbwheel controls. 

 
Chooses the Hand cursor, which allows image 
manipulation using the mouse directly in the 
image or by using the thumbwheel controls. 
(When the mouse is moved to the window 
border the Hand cursor changes to the Arrow 
cursor). 

 
This Help menu is inactive. 

 
Resets the view to a preset Home default 
position, size and orientation. 

 
Sets the default settings for the Home button. 

 
Restores the view to include the entire image. 

 
Activates the Seek cursor. After positioning this 
cursor on a selected point in the image and 
clicking the left mouse button, a close-up zoom 
to that point will be performed automatically. 
Also, the center of rotation will be set to that 
point. 

 ,   
Toggles between the Perspective and 
Orthographic projection modes. 
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There are also three thumbwheels along the 
window border, designated Dolly, Rotx, and 
Roty, which are used to zoom and rotate the 
image. 

The image can be rotated, translated, panned, and zoomed using the mouse 
with the Arrow cursor and the thumbwheel control knobs or using the mouse 
with the Hand cursor, as described below. 

Rotation Rotate the image using the mouse and the 
Arrow cursor with the thumbwheels labeled 
Rotx and Roty. Alternatively, use the mouse 
and the Hand cursor to directly rotate the 
image; Position the hand cursor over the image, 
depress the left mouse button, and drag the 
mouse to obtain the desired orientation. 

Pan/Translate While depressing the control key <CTRL>, use 
the mouse and the Hand cursor to directly pan 
the image. Position the hand cursor over the 
image, depress the left mouse button, depress 
the control key, and drag the mouse to move 
the image to the desired location. 

Zoom The method for zooming the image depends on 
the type of display projection selected. In the 
Perspective projection mode, use either the 
zoom control scroll bar at the bottom of the 
window, or use the Dolly thumbwheel at the 
lower right border of the window. In the 
Orthographic projection mode, use the Zoom 
thumbwheel at the lower right border of the 
window. You can also zoom by using the 
mouse. To zoom in or out hold the Ctrl + Shift 
keys down and drag the mouse toward (away 
from) the center while holding the left mouse 
button. 
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4.5.5. Beam Statistics 

The Beam Statistics window, as shown below, displays a tabular summary 
of beam parameters and statistics. Any or all of the computed beam 
parameters set up in the Data Analysis dialog may be viewed in this way. It 
is also used for Limit Analysis. The parameters for viewing are selected in the 
Beam Statistics Parameters dialog box. 

 
Limit Analysis 

Limit analysis can be performed on any of the parameters reported in the 
Beam Statistics window. The parameters are checked against user 
specified maximum and/or minimum values and the result of the analysis is 
displayed using icons in the Beam Statistics window, as shown above. To 
configure the analysis, either double click with the left mouse button on the 
desired parameter, or, alternatively, use the Up/Down Arrow keys to 
highlight the parameter and then press the Space key. This will open the 
following dialog box for setting the parameter limits for the analysis. 
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Either one or both limits can be set. The icons for reporting the analysis are: 

 Parameter value is within the set limit or limits. 

 Parameter value is greater than the maximum 
limit. 

 Parameter value is less than the minimum limit. 

The Options menu available when the Beam Statistics window is active 
offers the following selections: 

 

 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 

Reset Resets the Beam Statistics table. 

Parameters… Opens the Beam Statistics Parameters dialog, 
shown below, for selecting the parameters to be 
listed in the Beam Statistics table. Parameters 
available for selection are determined by the 
selections made in the Data Analysis dialog. 
Those parameters that are unavailable for display 
are grayed out in the dialog box. This dialog is also 
used to select which statistical quantities to list in 
the table for each parameter selected and how the 
statistics will be calculated. All the parameters are 
computed in accordance with ISO Standards. In 
addition, the setup for data logging to files or serial 
communication ports is made here. 
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Selection options in the Beam Statistics Parameters dialog box are listed below. 

  

Note: If a selection is not available or grayed out in this box, that option must 
first be turned on in the Data Analysis dialog box. In order to do this, go to 
Data Collection, select Data Analysis and then mark the appropriate 
selection. 

 Beam Width (when D slit is selected in the Data Analysis 
Dialog Box for ISO Profiles) 

  13.5% Beam diameter at 13.5% cliplevel, horizontal 
and vertical or major and minor axes. 

  36.8% Beam diameter at 36.8% cliplevel, horizontal 
and vertical or major and minor axes. 

  50.0% Beam diameter at 50% cliplevel, horizontal and 
vertical or major and minor axes. 

  60.7% Beam diameter at 60.7% cliplevel, horizontal 
and vertical or major and minor axes. 

  User % Beam Diameter at the User Specified clip level 
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value, horizontal and vertical or major and 
minor axes. 

 Beam Energy (when D energy is selected in the Data 
Analysis Dialog Box for ISO Profiles) 

  86.5% Beam diameter containing 86.5% of total 
energy, horizontal and vertical or major and 
minor axes. 

  63.2% Beam diameter containing 63.2% of total 
energy, horizontal and vertical or major and 
minor axes. 

  50.0% Beam diameter containing 50% of total energy, 
horizontal and vertical or major and minor 
axes. 

  39.3% Beam diameter containing 39.3% of total 
energy, horizontal and vertical or major and 
minor axes. 

  User % Beam diameter containing the user specified 
total energy, horizontal and vertical or major 
and minor axes. 

 Beam Width (when D 4Sigma is selected in the Data 
Analysis Dialog Box for ISO Profiles) 

  4Sigma Second-moment beam diameter, horizontal 
and vertical or major and minor axes. 

 Elliptical Analysis  

  Rotation Angle of the major axis with respect to 
horizontal. 

  Ellipticity Ellipticity Factor. 
  Eccentricity Eccentricity Factor. 
 Flat Top Analysis  

  Min Minimum value in the Energy ROI. 
  Max Maximum value in the Energy ROI. 
  Mean Mean value in the Energy ROI. 
  Flatness Flatness Factor. 
  Uniformity Uniformity Factor. 
  Energy % The percentage of Beam Area total energy or 

power in the Energy ROI. 
  Energy in ROI The energy or power in the Energy ROI. 
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 Centroid Location of the beam centroid reported in 
microns (µm) from the upper left corner of the 
image in the Beam Area. 

 Peak Location of the peak of the image in the Beam 
Area. 

 Irradiance The value of the irradiance at the peak 
location. 

 Total Energy The value of the total energy or power in the 
Beam Area. 

 Divergence Beam Divergence angle 

 Gaussian Fit Gaussian Goodness-of-Fit Value. 

 Pointing  

  Position The beam area Centroid from the Pointing 
window. 

  Angle The pointing angle from the Pointing window. 
  Radius Distance from the reference position in the 

Pointing window. 
 Statistics  

  Continuous Selects a continuous average of data samples. 
  Rolling Selects a rolling average with user-specified 

number of samples. 
  Finite Selects a finite average with user-specified 

number of samples. 
 Display  

  Value Selects display of the present value of the 
beam parameter. 

  Mean Selects display of the mean value of the beam 
parameter. 

  Min Selects display of the minimum value of the 
beam parameter. 

  Max Selects display of the maximum value of the 
beam parameter. 

  Std Dev Selects display of the standard deviation of the 
beam parameter. 

  Min Limit Selects display of the minimum limit value of 
the beam parameter set in Limit Analysis. 
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  Max Limit Selects display of the maximum limit value of 
the beam parameter set in Limit Analysis. 

 Logging  

  Output  
   None No data logging. 

   File Data logging to specified file. 

    Opens a Save As dialog box for selecting the 
path and file name for the log file. After you 
click OK the full path and file name will be 
displayed in the File edit box. 

   Port Data logging to serial port (COM). 

  Delimiter Selects the delimiter format for the logged data. 
   Date If selected, the date is attached to the logged 

file. 

   Time If selected, the time is attached to the logged 
file. 

   Serial 
Number 

If selected, the specified serial number is 
attached to the logged file. 

Font… Opens a dialog box for selecting the type and 
size. 

Log If data logging is enabled, one additional set of 
data is acquired and then displayed and/or 
logged to the file. If data collection is disabled 
for the Beam Statistics window, it allows the 
user to take individual data one set at a time 
and log into a file. The Hot Key ‘Ctrl+L’ enables 
logging even if another window is active as 
long as the Beam Statistics is open. 

Some of the options can also be selected from the Beam Statistics window 
toolbar: 

 

   Starts data collection 

 Stops data collection 

 Resets the Beam Statistics table 

 Opens Beam Statistics Parameters dialog 
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4.5.6. Time Statistics 

The Time Statistics windows display strip charts of beam parameters versus 
time. Any or all computed beam parameters may be viewed in this way. Up to 
15 Time Statistics windows can be opened. Several overlays are available 
in the Options menu, including grids, statistical markers, and numerical 
statistical summaries. 

 
The Options menu available when the Time Statistics windows are active 
offer the following selections: 
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Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate and for how long data will be 
acquired in the active chart. If Manual is 
checked, one set of data points will be acquired 
each time the user selects Data Collection. 

 
Reset Graph Resets the active Time Statistics window. (A 

message prompt warns the user that old data 
will be lost). 

Grid On When selected, a grid overlay is displayed on 
the Time Statistics graph. 

Mean When selected, an overlay plot of the mean 
value is displayed. 

Min/Max When selected, overlay plots of the minimum 
and maximum values are displayed. 

Standard Deviation When selected, an overlay plot of the standard 
deviation is displayed. 

Show Calculations When selected, the numerical values of the 
mean, minimum, maximum, and standard 
deviation values are displayed beneath the plot 
area. 

Font… Opens a dialog box for selecting the font type 
and size used in the chart. 
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Parameters… Opens the Parameters dialog box for selecting 
parameters to be plotted in the active Time 
Statistics window. 

 
The choice of parameters are limited to those 
which are presently being computed, as set up 
in the Data Analysis dialog accessed in the 
Data Collection menu. These are the same 
parameters available to the Beam Statistics 
window. In addition to selecting the parameters 
to be plotted, this dialog is used to set the color 
of the plotted lines. 

Axes… Opens a dialog box for selection of manual or 
automatic configuration of the axes in the Time 
Statistics display. 

 



4.54 FireWire BeamPro Installation and Operation Manual 

B050110806-1.30  Photon Inc. 

Some of the options can be selected using the Time Statistics window 
toolbar: 

 

 
Starts data collection 

 
Stops data collection 

 
Resets the Time Statistics graph 

 
Grid overlay on/off 

 
Statistical calculations overlay on/off 

 
Opens Time Statistics Parameters dialog 

 
Opens the Time Stat Axes dialog 

4.5.7. Pointing 
The Pointing window displays a screen that shows and tracks the location of 
the beam centroid with a colored dot or cross. An example is shown below. 
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It also displays a table showing the relative current position and the relative 
maximum position in the horizontal, vertical, and radial directions, and the 
corresponding angular displacement. Clicking on the colored box in the 
window opens a color selection dialog for choosing the color of the beam dot 
or cross indicator. A zoom control allows the user to scale the aperture of the 
pointing screen. 

The Options menu available when the Pointing window is active is shown 
below. 

 

 

The selections are:  

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate and for how long the window will 
update. 

 
Centroid Cross Selects the cross indicator for the centroid. If 

not selected the indicator is a dot. 
Beam Contour Overlay When selected, a beam contour overlay is 

drawn around the current centroid value. The 
overlay is a circle or ellipse with the 1/e²

 
width 

of the beam. 
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Accumulate Turns on the Accumulate mode, which 
displays centroid values for all subsequent data 
on the same plot, allowing observation of beam 
movement. 

Parameter Averages… Opens a dialog for setting the number of points 
to be used in a moving average of the centroid 
position value. 

 

Default 
 

 Load Opens a dialog for loading a previously saved 
pointing screen setup. 

 Save Opens a dialog for saving a pointing screen 
setup. 

4.5.8. Notes 
The Notes window is used for entering user information. When active, a 
cursor appears in the Notes window. Use the keyboard to enter text, and the 
arrow keys to navigate. There are no options available for the Notes window. 
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4.5.9. K-Factor (M²) Wizard 
The K-Factor Wizard window is an interactive program for determining the 
K-factor by the Rayleigh Method. The K-Factor Wizard window is a series of 
dialog boxes that prompt and guide the user through a series of 
measurements and data entries required for calculating the K-factor and M². 
The calculated values are displayed in the final dialog box.  

 
Setup the laser and sensor so that you can easily move the sensor along the 
Z-axis (nearer or farther from the laser). Then start the K-Factor wizard. 
Follow the instructions that appear. Measurements are performed for each 
aperture independently to allow for astigmatism and ellipticity. Upon 
completing each step, select the Next button to continue. If you make a 
mistake select the Previous button and redo that step. When you have 
completed all of the steps, the wizard will display the results. It’s that easy! 

For more information, please read Application Note 230 available from your 
Photon Inc. representative or the Photon website, www.photon-inc.com. 

The formula is: 

2
22

min

r

D
ZK

×
×

=
π
λ   or  

K
M 12 =  
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where: 

λ wavelength in nm 

rZ2  minmax ZZ −  – Rayleigh range 

minD  Beam diameter in the beam waist 

maxZ  Distance along Z axis where beam diameter is minD×414.1  
(distal to test lens or laser) 

minZ  Distance along Z axis on the other side of the waist where 
beam diameter is minD×414.1  (proximal to test lens or laser) 

4.5.9.1. Measuring the K-Factor 
The K-Factor is a propagation constant for a laser source defined in the ISO 
standard as 

22
221

min

r

D
Z

M
K

×
×

==
π
λ  

Physically, M can be thought of as a factor times the diffraction limit. For 
example, if one calculates the diffraction limit for a particular lens, the source 
with an 2.1=M  will produce a spot width 1.2 times the theoretical calculated 
value. 

The ISO standard requires 10 beam measurements and a curve-fitting 
algorithm. A faster method, called the Rayleigh method, provides accurate 
result with only 3 measurements. 

The Rayleigh Method can easily be derived from the definitions and gives 
fast, highly accurate and repeatable K-Factor values. This method requires 
you to measure twice the Rayleigh length for a source. A long focal length 
lens (high F# ≥20) should be used. You also need the wavelength and the 
minimum observed beam width, minD , while sweeping through the beam 
waist. 

4.5.9.2. Lens Selection and the Expected Rayleigh Length 
How does one select a focusing lens? How does one determine the Rayleigh 
distance for a source and a lens? 

We have found that the distance along the beam axis can be measured to 
the nearest 1/2mm if one selects a focused beam size from 80mm to 200mm 
(1/e2) beam width.  
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Example: 

Source nearly collimated wavelength 0.7µm and approximate exit beam 
width is 500µm (1/e2). 

The divergence for a diffraction limited source ( )1== KM  will be: 

rad0018.0
μm500
μm7.04;4

=
×
×

=
×
×

=
π

θ
π

λθ
D

; 

We can select the lens by assuming: 

θ×= fd  

or, if we want the predicted waist diameter d near the focal plane to be 
125µm, the required focal length is: 

69mm or μm444,69
0018.0
μm125

==f  

Let’s use a 75mm lens, which is more commonly found in a laboratory. The 
expected spot size is: 

μm1350018.0μm000,75 =×=×= θfd  

The expected Rayleigh length in the region of the waist will be: 

λ
π 2

4
dZ ×=  

where, d is the above 135µm calculated spot width. 

20.4mm or μm448,20
μm0.7

μm1357854.0 2

=
×

=Z  

mm8.40 or μm40,8962 =Z  

Thus we have a rough starting point for K-Factor measurements. If the 
K-Factor is much less than 1.0, the spot size will be larger than calculated 
and the Rayleigh length will be less than calculated. What is important is that 
by using the diffraction limited case one has a starting point. We suggest that 
one try this method with a small visible HeNe laser which is nearly always 
close to 1=K  to gain an appreciation for the method before trying an 
unknown source. If you get close to one with the HeNe source, you will have 
the measurement method understood! If you get 0.1>K , recheck alignment 
and go through the waist slowly enough to allow the software time to select 
the correct minimum waist. 
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4.5.9.3. Alignment  
To measure K-Factor, the user should position the sensor in the beam waist. 
Setup the laser and the sensor so the sensor can easily move along the 
Z-axis. This alignment is extremely important for getting accurate results!  

Alignment of the sensor and laser beam without the focusing lens: 
Before inserting the lens into the path, align the sensor axial travel motion 
parallel to the axis of the laser. We suggest that the non-alignment be no 
more than a couple of beam widths. For the example laser above, this would 
be ±500 microns. The Pointing window can be used to measure the 
misalignment over the Rayleigh range. 

For the example source (previous section) this means one should see no 
more than ±500µm motion either X or Y as one translates the sensor along 
the beam axis through a distance of 2Z (or 41mm for our example). 

Note! Move slowly through the waist region so the software can keep up with 
the measurement process.  

4.5.9.4. Insert the lens 
Once the sensor and source are aligned, insert and center the lens into the 
beam path. Now translate the sensor through the 2Z length and again try to 
keep the cross translation to less than ±1-2 beam widths. For the example 
beam, use the calculated 135µm as a goal. 

Be sure the lens is well centered or you will be measuring the lens aberration 
as well as the K-Factor for the source. With a visible source, one can usually 
observe a back reflection from both lens surfaces. Place the back-reflected 
beams just slightly to the side of the laser exit aperture. Sending the 
reflections back into the source may cause laser oscillations due to 
interference.  

Another centering approach is to use a machined centered removable 
aperture stop just before the lens. This could fit into the lens mount during 
alignment and be removed before measurements. Direct the beam through 
this small aperture (our source example uses a 2mm hole) during alignment. 
Be sure to remove the stop once aligned to prevent truncation of the source 
and consequently errors in measured K-Factors. 

Now you are ready to use the K-Factor Wizard. 
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4.5.9.5. Rayleigh Test Fixture Accessory 
Photon offers an accessory, a Rayleigh Test Fixture, which consists of a base 
plate, a slide that allows manual sensor axial [Z] translation and an LCD 
measurement ruler. The base plate is rigidly mounted to an optical table or 
rail. The translation distance readout is a Mitutoyo LCD ruler that spans 
150mm of travel and gives position values to the nearest 25µm. The total 
150mm travel allows the Rayleigh range to be such that a beam waist of 
approximately 200µm can be measured.  

The Mitutoyo scale can be zeroed at the first Rayleigh location, translated to 
the second to find a single direct read number in mm units to be inserted into 
the Wizard software. This accessory’s purpose is to make measurements of 
the Rayleigh range very easy and very repeatable. The user provides a 
source, a focusing lens and mount. 

 

Example Using the Rayleigh Test Fixture Accessory: 
1. Move the sensor to D Target for Aperture 1. Reset the Mitutoyo 

scale. Enter 0 for Z Position 1 under the Aperture 1 heading. 

2. Move the sensor to D Target for Aperture 2. Enter 10 for Z Position 1 
under the Aperture 2 heading. Select the Next button. 

3. Move slowly through the waist for Aperture 1 and verify the minD  is 
correct. 

4. Move slowly through the waist for Aperture 2 and verify the minD  is 
correct. 

5. Move the sensor to D Target for Aperture 1. Enter 24 for Z Position 2 
under the Aperture 1 heading. 

6. Move the sensor to D Target for Aperture 2. Enter 30 for Z Position 2 
under the Aperture 2 heading. Select the Next button. 

 

4.5.10. Measurement 
The Measurement window is available only with ModeScan Model 1780. 
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4.6. Toolbars 
Toolbars are provided to speed access to some of the most commonly used 
operations and features of the FireWire BeamPro Acquisition and Analysis 
Software. Instead of accessing these features through the pulldown menus, 
simply click on the appropriate icon buttons on the toolbars. The operations 
and features include: opening windows, turning data collection on and off, 
selecting the acquisition mode, turning Autotracking on and off, and 
selecting options. In addition, some file handling operations such as opening 
and saving files, opening new files and printing can be initiated in this way. 
General program features are accessed on the main toolbar, while option 
features for the Video window, Profile window, Beam Statistics window, 
and Time Statistics window are accessed on window toolbars. The toolbars 
and descriptions of their icon buttons and functions are given below.  

For user convenience and preference, toolbars can be placed at different 
screen locations by dragging and dropping. 

4.6.1. The Main Toolbar 

 

 
Opens a new file 

 
Opens the Open file dialog 

 
Saves the current file 

 
Opens the Print dialog 

 
Opens specific Help topics (currently inactive) 

 
Turns Autotracking on/off 

 
Turns Track Settings on/off (currently inactive) 

 
Turns Global Data Collection on/off 

     
Opens the Calibration dialog (also indicates 
the calibration status) 
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Sets system to Laser Positioning mode 

 
Sets system to Analysis mode 

 
Sets system to Single Shot mode  

 
Opens the Profile window 

 
Opens the Video window 

 
Opens the 3D Profile window. Up to 5 2D and 
3D windows combined can be opened. 

 
Opens the 2D Contour window 

 
Opens the Beam Statistics window 

 
Opens the Time Statistics windows. Up to 15 
windows can be opened simultaneously. 

 
Opens the Pointing window 

 
Opens the K-Factor window 

 
Opens a Measurement window (available only 
with ModeScan Model 1780) 

 
Opens the Notes window. 

4.6.2. The Video Window Toolbar 

 

 Set Beam Area drawing tool 

 Energy ROI: Elliptical region drawing tool 

 Energy ROI: Circular region drawing tool 

 Energy ROI: Rectangular region drawing tool 

 Energy ROI: Square region drawing tool 
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4.6.3. The Profile Window Toolbar 

 

 Starts data collection 

 Stops data collection 

 Gaussian Fit overlay on/off 

 Turns Normalization on/off 

4.6.4. The Beam Statistics Window Toolbar 

 

 Starts data collection 

 Stops data collection 

 Resets the Beam Statistics table 

 Opens Beam Statistics Parameters dialog 

4.6.5. The Time Statistics Window Toolbar 

 

 Starts data collection 

 Stops data collection 

 Resets the active Time Statistics graph 

 Grid overlay on/off 

 Statistical calculations overlay on/off 

 Opens Time Statistics Parameters dialog 

 Opens Time Stat Axes dialog 
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4.7. Status Bar 
The status bar at the bottom of the screen displays the camera settings (gain 
and exposure), cursor location and the Beam Area information. The first pane 
displays the camera settings: gain (in dB) and exposure (in ms). The second 
pane displays the intensity in counts at the mouse cursor location (when is 
pointing over the Live Window), given by position coordinates in microns, 
from the upper left corner. The third pane displays the position coordinates of 
the upper left corner in the Beam Area (BA) and the dimensions in microns of 
the Beam Area. The fourth pane displays the update rate in frames/second 
while global data collection is turned on. The last pane displays information 
about the calibration status. 

 

4.8. ActiveX Automation 

FireWire BeamPro Acquisition and Analysis Software provides a Microsoft 
Automation interface. As an automation server, FireWire BeamPro 
Acquisition and Analysis Software exposes a set of methods and properties. 
Using ActiveX compatible programs such as LabVIEW or Microsoft Excel, a 
user can create his own Automation controller, which can display and 
process data from FireWire BeamPro Acquisition and Analysis Software. 

The type library “FWBeamPro.tlb” file in the Automation folder where the 
software has been installed contains a full description of the ActiveX 
interface. You can open and view this file with an OLE/COM viewer program. 

The properties and methods that FireWire BeamPro Analysis Software 
exports are explained below. 

4.8.1. ShowWindow 
Property Type: 
VT_BOOL – Show flag 
Remarks: 
Shows or hides the FireWire BeamPro Analysis Software main window. Call 
this function with TRUE if you want to show the FireWire BeamPro Analysis 
Software. Call this function with FALSE as parameter to hide the FireWire 
BeamPro Analysis Software. 
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4.8.2. AcquisitionMode 
Property Type:  
VT_I2 – acquisition mode 
Remarks: 
Gets or sets acquisition mode. 
Possible values are defined in the type library file by the 
SelectionAcquisitrionMode enumeration: 

Acquisition Mode Selection Value Comments 

SEL_ACQMODE_ANALYSIS 0 Analysis Acquisition Mode 

SEL_ACQMODE_LASERPOS 1 Laser Positioning Acquisition 
Mode 

SEL_ACQMODE_SINGLESHOT 2 Single Shot Acquisition Mode 

4.8.3. TriggerMode 
Property Type:  
VT_I2 – trigger mode 
Remarks: 
Gets or sets trigger mode. 
Possible values are defined in the type library file by the 
SelectionTriggerMode enumeration: 

Trigger Mode Selection Value Comments 

SEL_TRIGGER_CW 0 Trigger Mode – CW 

SEL_TRIGGER_PULSED 1 Trigger Mode – Pulsed 

SEL_TRIGGER_EXT 2 Trigger Mode – External 

4.8.4. ImageRotation 
Property Type: 
VT_I2 – image rotation 
Remarks: 
Gets or sets the clockwise rotation of the image from the original frame. 
Possible values are 0, 90, 180 or 270. 
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4.8.5. ImageFlip 
Property Type:  
VT_I2 – image flip 
Remarks: 
Gets or sets the orientation of the image with respect to Vertical and 
Horizontal. 

Possible values are defined in the type library file by the ImageFlipSelection 
enumeration: 

Image Flip Selection Value Comments 

SEL_FLIP_NONE 0 Display the original frame 

SEL_FLIP_HORIZ 1 Flip the image about the horizontal axis 

SEL_FLIP_VERT 2 Flip the image about the vertical axis 

4.8.6. MagnificationFactor 
Property Type: 
VT_R4 – magnification factor 
Remarks: 
Gets or sets the external optics magnification factor. The range for the 
magnification factor value is between 0.01 and 1000. 

4.8.7. Averaging 
Property Type 
VT_I2 – average value 
Remarks: 
Gets or sets the number of frames used in averaging. The range for the 
average value is between 1 and 1000. 

4.8.8. CameraExposure 
Property Type 
VT_R4 – camera exposure 
Remarks: 
Gets or sets the exposure time for the camera, in ms. The range for the 
exposure value is between 0.02 to 81.90 for the Models 2518 and 2523 and 
between 0.02 and 27.52 for the Model 2512. The exposure increment is 
0.02ms. 
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4.8.9. CameraGain 
Property Type 
VT_I2 – camera gain 
Remarks: 
Gets or sets the gain for the camera, in dB. The range for the gain value is 
between 0 and 12 for Models 2512 and 2523 and between 0 and 7 for 
Model 2518. 

4.8.10. CameraAutoSettings 
Method Return Value: 
VT_BOOL –Automatic Settings status 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Performs a one-shot automatic setting of exposure and gain. If the operation 
was successful, the method returns TRUE, otherwise returns FALSE. 

4.8.11. AngleUnits 
Property Type:  
VT_I2 – angle units 
Remarks: 
Gets or sets the units used for reporting all the angles. Possible values are 
defined in the type library file by the SelectionAngleUnits enumeration: 

Angle Units Selection Value Comments 
SEL_ANGLE_UNITS_MRAD 0 Reports all the angles in milliradians 
SEL_ANGLE_UNITS_DEG 1 Reports all the angles in degrees 

4.8.12. GlobalDataCollection 
Property Type:  
VT_BOOL – global data collection 
Remarks: 
Starts or stops global data collection and queries the state of it. 

4.8.13. AutoTracking 
Property Type:  
VT_BOOL – auto track 
Remarks: 
Enables or disables the auto track feature and queries the state of it. 
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4.8.14. SetBeamArea 
Method Return Value: 
VT_BOOL – TRUE if Beam Area has been modified successfully, FALSE 
otherwise. 
Method Parameter List: 
VTS_R4 – left 
VTS_R4 – right 
VTS_R4 – top 
VTS_R4 – bottom 
Remarks: 
Sets a manual Beam Area. Turn AutoTrack off before you use this function, 
otherwise the Beam Area may change automatically while the software is 
trying to track the beam. The parameter list values are the coordinates of the 
Beam Area rectangle in microns, from the upper left corner of the array 
(which is (0,0)). If the Beam Area cannot be set (the coordinates are not 
within the array range), the return value is FALSE. If the Beam Area has 
been modified successfully, the return value is TRUE. 

4.8.15. GetBeamArea 
Method Return Value: 
VT_BOOL – Beam Area status 
Method Parameter List: 
VTS_PR4 – left 
VTS_PR4 – top 
VTS_PR4 – right 
VTS_PR4 – bottom 
Remarks: 
Gets the Beam Area coordinates. The parameter list values are the 
coordinates of the Beam Area rectangle in microns, from the upper left 
corner of the array (which is (0, 0) ). If there is no Beam Area the return value 
is FALSE. If there is a valid Beam Area the return value is TRUE. 
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4.8.16. DoCalibration 
Method Return Value: 
VT_BOOL – TRUE if calibration was successfully, FALSE otherwise. 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Performs a calibration routine for the camera. 

4.8.17. IsCalibrated 
Method Return Value: 
VT_BOOL - calibration status. 
Method Parameter List: 
VTS_PDATE – date when the system calibration occurred. 
Remarks: 
This method returns the calibration status of the system. 

4.8.18. BackgroundCorrection 
Property Type: 
VT_I2 – background correction method 
Remarks: 
Gets or sets the method used for subtracting the camera background. 
Possible values are defined in the type library file by the 
SelectionBackgroundSubtraction enumeration: 

Acquisition Resolution Selection Value Comments 

SEL_BKGND_NONE 0 No background subtraction 

SEL_BKGND_FRAME 1 Frame subtraction 

SEL_BKGND_MEAN 2 Mean subtraction 

4.8.19. ComputationsDone 
Property Type: 
VT_BOOL – computations status 
Remarks: 
Gets or sets the status of the frame computation. If this flag is TRUE that 
means that at least one frame was acquired and processed. Set this flag to 
FALSE before initiate a data acquisition and then wait until the state is TRUE 
in order to be sure a new frame was acquired and processed. 
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4.8.20. Recompute 
Method Return Value: 
VT_EMPTY – none 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Redo computations for selected parameters based on the current settings. 
Computations are done on the image data that is currently in memory. 

4.8.21. IsSaturated 
Method Return Value: 
VT_BOOL – saturation flag 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns TRUE if signal is saturated, FALSE otherwise. 

4.8.22. ISOWidthMethod 
Property Type: 
VT_I2 – method for computing beam width 
Remarks: 
Gets or sets the method used for computing beam widths. 
If the 4Sigma method is selected, only the 1/e2 clip level beam width is 
computed. 
Possible values are defined in the type library file by the SelectionISOWidth 
enumeration: 

ISO Width Method Selection Value Comments 

SEL_ISO_D_SLIT 1 Slit method used for computing 
beam widths. 

SEL_ISO_D_ENERGY 2 Encircled energy method used for 
computing beam widths. 

SEL_ISO_D_4SIGMA 3 Second moment method (4Sigma) 
used for computing beam widths. 
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4.8.23. UseCliplevel 
Method Return Value: 
VT_EMPTY – none 
Method Parameter List: 
VTS_R4 – cliplevel in percentage 
VTS_BOOL – use 
Remarks: 
Enables or disables beam width computation at the specified clip level. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level.  
To enable beam width computation at a specified clip level, set the use flag to 
TRUE. To disable beam width computation at a specified clip level, set the 
use flag to FALSE. 
Without this function call, the beam width numbers returned from FireWire 
BeamPro may not be valid. 
This function has to be called only once, at the beginning of the program, 
before any call to GetWidth, GetEllipticity, GetEccentricity or 
GetPeakDivergence. 

4.8.24. GetWidth 
Method Return Value: 
VT_R4 – beam width 
Method Parameter List: 
VTS_I2 – axis 
VTS_R4 – cliplevel 
Remarks:  
Returns the beam width in microns. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
If the selected ISO method for computing the beam width is Energy, then 
only one beam width number is computed. In this case, the beam width 
values for axis 0 and axis 1 are equal. 
If the selected ISO method for computing the beam width is 4Sigma, then 
only the beam width is computed. The specified “clip level” must be 1/e2. 
To enable beam width computations for the specified clip level, UseCliplevel 
has to be called before the first call to GetWidth. 
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4.8.25. GetPeakPosition 
Method Return Value: 
VT_R4 – peak position 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the peak position in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.26. GetCenter 
Method Return Value: 
VT_R4 – centroid position 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the centroid position in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.27. GetPeakIrradiance 
Method Return Value: 
VT_I2 – peak irradiance 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the irradiance of the peak. Possible values are 0…4095. 
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4.8.28. EllipticAnalysis 
Property Type: 
VT_BOOL – elliptic analysis 
Remarks: 
Gets or sets the elliptical analysis state. 
If the state is TRUE, the elliptical analysis is enabled and GetRotationAngle, 
GetEllipticity and GetEccentricity will return valid numbers. If the state is 
FALSE, the elliptical analysis is disabled. 

4.8.29. GetRotationAngle 
Method Return Value: 
VT_R4 – rotation angle 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the orientation of the computed major axis (the angle is reported in 
trigonometric direction). 
This function returns valid numbers only if elliptical analysis has been 
enabled, using EllipticAnalysis property. 

4.8.30. GetEllipticity 
Method Return Value: 
VT_R4 – ellipticity 
Method Parameter List: 
VTS_R4 – cliplevel 
Remarks: 
Returns the ellipticity of the beam. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. In this case, the 
ellipticity will be 1, because there is only one beam width value. 
This function returns valid numbers only if elliptical analysis has been 
enabled, using EllipticAnalysis property. 
Also the beam width computation for the specified clip level should have 
been enabled, using UseCliplevel, because the beam width numbers are 
used in the computation of the ellipticity. 
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4.8.31. GetEccentricity 
Method Return Value: 
VT_R4 – eccentricity 
Method Parameter List: 
VTS_R4 – cliplevel 
Remarks: 
Returns the eccentricity of the beam. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. In this case, the 
eccentricity will be 0, because there is only one beam width value. 
This function returns valid numbers only if elliptical analysis has been 
enabled, using EllipticAnalysis property. 
Also the beam width computation for the specified clip level should have 
been enabled, using UseCliplevel, because the beam width numbers are 
used in the computation of the eccentricity. 

4.8.32. GetTotalEnergy 
Method Return Value: 
VT_R4 – total energy 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns total sum of the pixels inside of the defined Beam Area. 

4.8.33. FlatTopThreshold 
Property Type: 
VT_R4 - flat top threshold 
Remarks: 
Gets or sets the threshold value (percentage of the peak pixel value) used for 
flat top analysis. 
The allowed range of the threshold is between 0 and 100. 
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4.8.34. FlatTopAnalysis 
Property Type: 
VT_BOOL – flat top analysis 
Remarks: 
Gets or sets the flat top analysis state. 
Flat top numbers will be computed over a Region of Interest that can be 
user-defined. 
If the state is TRUE, the flat top analysis is enabled and GetFlatTopMin, 
GetFlatTopMax, GetFlatTopMean, GetFlatTopFlatness, GetFlatTopUniformity 
and GetFlatTopEnergy will return valid numbers. If the state is FALSE, the 
flat top analysis is disabled. 

4.8.35. GetFlatTopMin 
Method Return Value: 
VT_R4 – flat top minimum 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the minimum pixel value in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.36. GetFlatTopMax 
Method Return Value: 
VT_R4 – flat top maximum 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the maximum pixel value in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 
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4.8.37. GetFlatTopMean 
Method Return Value: 
VT_R4 – flat top mean 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the mean value of all pixels in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.38. GetFlatTopFlatness 
Method Return Value: 
VT_R4 – flat top flatness 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the beam flatness in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.39. GetFlatTopUniformity 
Method Return Value: 
VT_R4 – flat top uniformity 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the beam uniformity in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 
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4.8.40. GetFlatTopEnergy 
Method Return Value: 
VT_R4 – flat top energy 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the total sum of the pixels inside of the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis and if energy analysis has been enabled. 

4.8.41. GaussianFitAnalysis 
Property Type: 
VT_BOOL – Gaussian Fit analysis 
Remarks: 
Gets or sets the Gaussian analysis state. 
If this state is TRUE, the 1-dimensional Gaussian analysis is enabled and 
Gaussian fit numbers can be computed using Get1dGaussianFit. If the state 
is FALSE the Gaussian Fit analysis is disabled. 

4.8.42. Get1dGaussianFit 
Method Return Value: 
VT_R4 – Gaussian fit 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns Gaussian fit numbers. 
This function returns valid numbers only if Gaussian Fit analysis has been 
enabled, using GaussianFitAnalysis. 
Gaussian fit numbers are computed for the profiles, either pinhole or slit scan 
through the data. In FireWire BeamPro these profiles and their 
correspondent Gaussian fitted profiles can be visualized in the Profile view. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis property), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
The profile type (slit or pinhole scan) can be modified with the ProfileType 
method; for the pinhole scans the Cross Hair type can be modified using the 
ProfileCrossHairsType method, while the position can be modified using and 
SetProfileCrossHairsPos, respectively GetProfileCrossHairsPos properties. 
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4.8.43. SetDivergenceMethod 
Method Return Value: 
VT_EMPTY – none 
Method Parameter List: 
VTS_I2 – divergence method 
VTS_R4 – distance 
VTS_R4 – cliplevel 
Remarks: 
Sets the divergence method and associated parameters used for the 
divergence calculation. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. 
Possible values for divergence method are defined in the type library file by 
the SelectionDivergenceMethod enumeration: 

Divergence Method Selection Value Comments 

SEL_DIV_METHOD_OFF 0 No divergence computations. 

SEL_DIV_METHOD_LENS 1 Lens method for computing 
divergence. 

SEL_DIV_METHOD_PTSRC 2 Point Source method for 
computing divergence. 

SEL_DIV_METHOD_NA 3 Numerical Aperture method for 
computing divergence. 

The distance parameter represents the Focal Length if the Lens method has 
been selected, or the Distance from the Point Source if the method is Point 
Source or Numerical Aperture. 

4.8.44. GetDivergenceMethod 
Method Return Value: 
VT_EMPTY – none 
Method Parameter List: 
VTS_PI2 – divergence method 
VTS_PR4 – distance 
VTS_PR4 – cliplevel 
Remarks: 
Gets the divergence method and associated parameters used for the 
divergence calculation. 
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4.8.45. GetDivergence 
Method Return Value: 
VT_R4 – divergence 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the divergence. 
Before measuring divergence, the divergence parameters should have been 
set using SetDivergenceMethod property and the beam width computation 
should have been enabled for the specified clip level using UseCliplevel 
property. 
The divergence is returned in the unit selected by AngleUnits if the selected 
divergence method is Lens or PointSource and is unitless if the selected 
divergence method is NumericAperture. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis property), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.46. ProfileType 
Property TYpe 
VT_I2 – profile type 
Remarks: 
Gets or sets the profile types, either Pinhole or equivalent Slit. The value set 
with this function will impact the arrays obtained by GetProfileData method. 
Possible values are defined in the type library file by the ProfileTypeSelection 
enumeration: 

Profile Type Selection Value Comments 

SEL_PROFILE_PINHOLE 0x00 Pinhole profiles through the crosshairs. 

SEL_PROFILE_SLIT 0x01 Equivalent slit profiles. 
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4.8.47. ProfileCrossHairsType 
Property Type 
VT_I2 – profile cross hairs 
Remarks: 
Gets or sets profile cross hairs type. If the Profile Type is set to Slit 
(Equivalent Slit Profiles) the only option available is Centroid.  
Possible values are defined in the type library file by the 
SelectionProfileCrossHairsType enumeration: 

Profile Cross Hairs Selection Value Comments 

SEL_XHAIR_CENTROID 0 Cross hairs through the centroid 

SEL_XHAIR_PEAK 1 Cross hairs through the peak 

SEL_XHAIR_USERDEF 2 Cross hairs through a user 
defined position 

4.8.48. SetProfileCrossHairsPos 
Method Return Value: 
VT_BOOL –flag indicating if position for profile Cross Hairs has been 
modified successfully 
Method Parameter List: 
VTS_R4 – posHoriz 
VTS_R4 – posVert 
Remarks: 
Sets the position (horizontal and vertical) for the user defined crosshairs, in 
microns (the point of coordinates (0, 0) is the upper left corner of the array). 
This method can be called only if the Profile Type is set to Slit (Equivalent Slit 
Profiles). 
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4.8.49. GetProfileCrossHairsPos 
Method Return Value: 
VT_BOOL – flag indicating if position for profile Cross Hairs has been 
retrieved successfully 
Method Parameter List: 
VTS_PR4 – posHoriz 
VTS_PR4 – posVert 
Remarks: 
Retrieves the position (horizontal and vertical) for the crosshairs, in microns. 
The point of coordinates (0, 0) is the upper left corner of the array. 

4.8.50. GetProfileData 
Method Return Value: 
VT_VARIANT – profile data array 
Method Parameter List: 
VTS_I2 – axis 
VTS_I4 – start index 
VTS_I4 – number of points 
Remarks: 
Returns an array of data points that represent a pinhole or slit scan through 
the beam area. (In FireWire BeamPro interface these profiles can be 
visualized in the Profile view.) 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis property), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
Start index represents the index in the pinhole scan data array that will 
correspond to the first data point returned. 
Number of points represents how many points will be copied in the returned 
array. 
The profile type (slit or pinhole scan) can be modified with the ProfileType 
method; for the pinhole scans the Cross Hair type can be modified using the 
ProfileCrossHairsType method, while the position can be modified using and 
SetProfileCrossHairsPos, respectively GetProfileCrossHairsPos properties. 
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4.8.51. GetProfileSampleSize 
Method Return Value: 
VT_R4 – sample size 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the sample size: the distance between two data points of the profile 
data array, in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis property), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.52. GetProfileNumPts 
Method Return Value: 
VT_I2 – number of points 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the number of points in the profile data array, which is bound, by the 
beam area. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis property), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.53. GetSampleSize 
Method Return Value: 
VT_R4 – sample size 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the dimension of one pixel from the data array, in microns. 
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4.8.54. GetNumPts 
Method Return Value: 
VT_I4 – number of points 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the number of points inside the beam area along the designated 
axis. 
Possible values for the axis are 0 and 1. If  analysis has been enabled (see 
EllipticAnalysis property), 0 represents the major axis and 1 the minor axis. 
Otherwise 0 is the horizontal axis and 1 the vertical axis, where horizontal 
and vertical are relative to the camera. 

4.8.55. GetTotalSize 
Method Return Value: 
VT_I4 – total size 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the total span of the profiles, either slit or pinhole, in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis property), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.56. GetStartPos 
Method Return Value: 
VT_I4 – start position 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the distance from the edge of the camera chip to the beam area in 
microns. 
Possible values for the axis are 0 (horizontal) and 1 (vertical), where 
horizontal and vertical are relative to the camera. 



Chapter 4.  Acquisition and Analysis Software 4.85 

Photon Inc.  B050110806-1.30 

4.8.57. Get2DData 
Method Return Value: 
VT_VARIANT – 2D data array 
Method Parameter List: 
VTS_R4 – left 
VTS_R4 – top 
VTS_R4 – right 
VTS_R4 – bottom 
VTS_I2 – decimation 
Remarks: 
Returns a 2D-array (matrix) of data points representing the 2D intensity data 
(values between 0 and 4095). The first four values from the parameter list 
are the coordinates of the rectangle area from where the data is exported, in 
µm, the coordinates are reported from the upper left corner of the array 
(which is (0, 0)). The decimation value can be used to read out a smaller 
array of data and it is used in both lines and columns of the matrix (transfer 
every nth pixel on every nth line, where n is the decimation value). 

4.8.58. SaveFrameAsTIFF 
Method Return Value: 
VT_BOOL – Save Flag status 
Method Parameter List: 
VTS_BSTR – file full name (with qualified path if necessary) 
Remarks: 
Saves the current frame (raw image) as an uncompressed 16-bit TIFF file. If 
the operation was successful, the method returns TRUE, otherwise returns 
FALSE. 
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4.8.59. GetCameraList 
Method Return Value: 
VT_VARIANT – array of strings; each string uniquely corresponds to a 
camera present on the system 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Call this property to retrieve the number of cameras present on the system, 
and for each camera the uniquely associated corresponding string (camera 
identifiers). The first element in the array always corresponds to the camera 
that is currently used by the FireWire BeamPro software. These strings need 
to be passed as parameter to SelectCamera method in order to select a 
specific camera. 

4.8.60. SelectCamera 
Method Return Value: 
VT_BOOL – Camera Select status 
Method Parameter List: 
VTS_BSTR – Camera identfier 
Remarks: 
Selects a different camera for use with the FireWire BeamPro software. To 
select a camera pass the uniquely associated string with the camera that 
was listed in the GetCameraList method. 

If the operation was successful, the method returns TRUE, otherwise returns 
FALSE. 

After a new camera was selected the system is not calibrated and the global 
data collection is turned off. If a different model camera was selected it is 
possible that Beam area, Region of interest and the user defined cross hairs 
position may be automatically modified by the software; therefore it is highly 
recommended either to set the desired values or to retrieve the values from 
the software and check them against the desired values. Also it is 
recommended to retrieve other important parameters from software, i.e. the 
sample size. 
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4.8.61. IsBeamPropagation 
Method Return Value: 
VT_BOOL – Beam Propagation Availability. 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns TRUE if the selected camera is part of ModeScan Model 1780 and 
therefore allows the software to enable Beam Propagation Analysis mode. 

4.8.62. BeamPropagationAnalysis 
Property Type: 
VT_BOOL – Beam Propagation analysis 
Remarks: 
Gets or sets the Beam Propagation analysis state. 
If this state is TRUE, the Beam Propagation analysis is enabled and Beam 
Propagation parameters be computed. Also, all the Beam Propagation 
characteristics can be set or get if this analysis is on. If the state is FALSE 
the Beam Propagation analysis is disabled. 
To set this property to TRUE the system should be part of the ModeScan 
Model 1780 (it can be verified with IsBeamPropagation method). 

4.8.63. SetBeamPropagationParameters 
Method Return Value: 
VT_BOOL – TRUE if Beam Propagation parameters were set successfully, 
FALSE otherwise. 
Method Parameter List: 
VTS_R4 – laser wavelength 
VTS_R4 – laser reference position 
VTS_R4 – lens focal length 
VTS_R4 – lens nominal position 
Remarks: 
Returns TRUE if all the following are all true: the selected camera is part of 
the ModeScan Model 1780 system, the Beam Propagation Analysis mode is 
enabled and all the parameters were set successfully. In all the other cases 
the method returns FALSE. The laser wavelength is specified in nm, while all 
the other parameters are specified in mm. The lens nominal position, the 
laser reference position and the focal length must be positive numbers. 
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4.8.64. GetBeamPropagationParameters 
Method Return Value: 
VT_BOOL – TRUE if Beam Propagation parameters were retrieved 
successfully, FALSE otherwise. 
Method Parameter List: 
VTS_PR4 – laser wavelength 
VTS_PR4 – laser reference position 
VTS_PR4 – lens focal length 
VTS_PR4 – lens nominal position 
Remarks: 
Retrieves the parameters associated with Beam Propagation Analysis mode. 
The parameter list values are the laser wavelength (in nm), the laser position 
(in mm), the lens focal length (in mm) and the lens position (in mm). If the 
Beam Propagation Analysis (see the BeamPropagationAnalysis property) is 
not enabled this method returns FALSE. 

4.8.65. GetBeamPropagationRatio 
Method Return Value: 
VT_R4 – Beam propagation ratio (M²) 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the beam propagation ratio. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see the EllipticAnalysis property), 0 represents the major axis and 1 
the minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, 
where horizontal and vertical are relative to the camera. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 
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4.8.66. GetBeamWaistSize 
Method Return Value: 
VT_R4 – Beam waist size (in µm) 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the beam propagation ratio. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see the EllipticAnalysis property), 0 represents the major axis and 1 
the minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, 
where horizontal and vertical are relative to the camera. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 

4.8.67. GetBeamWaistLocation 
Method Return Value: 
VT_R4 – Beam waist location (in mm) 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the beam waist location. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see the EllipticAnalysis property), 0 represents the major axis and 1 
the minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, 
where horizontal and vertical are relative to the camera. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 
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4.8.68. GetRayleighRange 
Method Return Value: 
VT_R4 – Rayleigh range (in mm) 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the Rayleigh range. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see the EllipticAnalysis), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 

4.8.69. GetAstigmatism 
Method Return Value: 
VT_R4 – Astigmatism value (in %) 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the beam astigmatism value. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 

4.8.70. GetWaistAsymmetry 
Method Return Value: 
VT_R4 – Beam Waist Asymmetry value 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the beam waist asymmetry value. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 
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4.8.71. GetDivergenceAsymmetry 
Method Return Value: 
VT_R4 – Divergence Asymmetry 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Returns the divergence asymmetry value. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 

4.8.72. GetBeamWaistWidthFromFit 
Method Return Value: 
VT_R4 – Beam Waist Width determined by the hyperbolic curve fit 
Method Parameter List: 
VTS_I2 – axis 
Remarks: 
Returns the beam waist width determined by the hyperbolic curve fit. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see the EllipticAnalysis), 0 represents the major axis and 1 the 
minor axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
The Beam Propagation Analysis must be enabled (see the 
BeamPropagationAnalysis property) and all the parameters set appropriate 
in order to obtain accurate results. 

4.8.73. IsFitWeighted 
Method Return Value:  
VT_BOOL – Returns true if the fit is weighted, false otherwise 
Method Parameter List:  
VTS_PI2 – Weight Power -- Output parameter to contain the weighted fit 
power 
Remarks:  
Weight power will always be set to 2, in this version of the software. This 
output parameter was included in case future versions allow changing of the 
weighting power.  
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4.8.74. SetFitWeighting 
Method Return Value:  
VT_BOOL – Returns true if successful, false otherwise 
Method Parameter List:  
VTS_BOOL – Weight fit flag – Pass TRUE for a weighted fit, and FALSE for 
un-weighted 
VTS_PI2 – Weight Power -- Weighted fit power to use 
Remarks:  
Weight power must be 2 in this version of the software, if it is not the function 
will fail. Currently changing the fit weighting is not supported. This parameter 
was included in case future versions allow changing of the weighting power.  

4.8.75. Example files 

In the Automation folder under the folder where the software has been 
installed (the default settings is “C:\Program Files\Photon\FireWire 
BeamPro”) there are two detailed examples about using ActiveX: one written 
in Visual Basic for Application (VBA) using Microsoft Excel “FireWire 
BeamPro ActiveX Example.xls” and one developed in LabView “FireWire 
BeamPro ActiveX Example.vi”. 
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AAppppeennddiixx    

Mechanical Dimensions 

1. Model 2512 

Mechanical dimensions of Model 2512 
1/2" IEEE 1394 FireWire BeamPro Camera 
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2. Model 2518 

Mechanical dimensions of Model 2518  
1/1.8" IEEE 1394 FireWire BeamPro Camera 

 

 

Mounting plate for Model 2518:  67.1mm W ×  36.0mm H × 8.0mm D 
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3. Model 2523 

Mechanical dimensions of Model 2523 
2/3" IEEE 1394 FireWire BeamPro Camera 
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